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Beginning in Sync version 4.30, Mylyn connectors will no longer be supported. If using Mylyn
connectors in a version earlier than 4.30, you should migrate to SDK connectors before
upgrading.

This can be done by first upgrading to version 4.29 and then upgrading to version 4.30.

Legacy Connectors

Tasktop Sync allows teams to synchronize tasks across different defect and task tracking repositories.
The Tasktop Sync server application places itself in between repositories to synchronize changes made
to the defects or tasks in either repository.

This guide lists legacy repository connectors certified to work with Tasktop Sync. Each section
describes a certified connector together with documentation regarding installation requirements,
common setup problems, and other issues that pertain to that specific connector.

Atlassian JIRA Connector [pre Sync 3.5]

Borland StarTeam Connector

CA Agile Planning and CA Clarity Requirements Connector

CA Project and Portfolio Management Connector For Sync [pre Sync 4.1]
HPE QC / ALM Connector [pre Sync 3.5]

IBM Rational DOORS Next Gen Connector [pre Sync 4.0]

IBM Rational Team Concert SDK Connector

Microsoft Team Foundation Server Connector [pre Sync 4.2]

Mozilla Bugzilla Connector

Serena Business Manager Connector [pre Sync 4.1]

Synchronizing Pairs of Connectors

This section describes how to set up Sync configurations for some common pairs of Tasktop
connectors.



Synchronizing Atlassian JIRA [pre Sync 3.5] with HPE QC / ALM [pre Sync 3.5]
Synchronizing Borland StarTeam with HPE QC / ALM [pre Sync 3.5]

Synchronizing CA Project and Portfolio Management [pre Sync 4.1] with IBM Rational Team Concert
(using IBM Rational Team Concert SDK)

Synchronizing CA Project and Portfolio Management [pre Sync 4.1] with Microsoft Team Foundation
Server

Synchronizing IBM Rational DOORS Next Gen [pre Sync 4.0] with HPE QC / ALM [pre Sync 3.5]

Synchronizing IBM Rational Team Concert (using IBM Rational Team Concert SDK) with HPE QC /
ALM [pre Sync 3.5]

Synchronizing Serena Business Manager [pre Sync 4.1] with HPE QC / ALM [pre Sync 3.5]

Synchronizing Time Worked From Atlassian JIRA [pre Sync 3.5] to CA Project and Portfolio
Management [pre Sync 4.1]



It is recommended to use Atlassian JIRA server-side queries (or “filters” in JIRA) for the Changes Query
and Initialization Query, because it is easier to check that the queries are working over the JIRA web Ul by
looking at the query results.

To create a JIRA server-side query (“filter”), in the Web Ul for JIRA, select | ssues > New. There is the
choice of a si npl e or advanced search; the advanced search allows relative dates.

For example, to get the tasks which have changed in the past two days, use:

updated >="-2d"

When the Changes Query is created, make sure that the time scoping works properly before using it in
Tasktop Sync.

Once the query has been defined, click on the Sear ch button, and then in the left-hand pane, click on Sav
e it as a filter.There will be a page which asks for a name and a description. The name here will
need to match the name in synchr oni zer . xm exactly. It is recommended to use a name with three
parts: “Tasktop Sync”, the project name, and a description of what is returned, e.g. “Tasktop Sync - Cobra
Project JIRA - Recently Modified Defects”.

JIRA does not have the concept of links, so a custom field for storing Tasktop Sync proxy associations will
need to be created. It must be a free text field, global (all issues). In synchr oni zer . xm , the custom field
will be referred to with with the custom field ID, so the name is arbitrary. It is recommended to name this
field t askt op_sync_pr oxy for documentation purposes.

Tasktop Sync requires the ID of this custom field.

To find the custom field ID, go to the JIRA web interface and sign in as an administrator. Select Adm ni st
r at i on from the header on the right side, then click on | ssues, and select Vi ew Cust om Fi el ds. On
the right hand side of the entry of the relevant field, there will be a link for Conf i gur e. The custom Field
ID will be in the last part of that URL, e.g. if clicking Conf i gur e links to ht t p: / / exanpl e. com 8080

/ secur e/ admi n/ Confi gur eCust onti el d! def aul t. j spa?cust onfi el dl d=10000, then the
customfield IDisattri bute.jira.custom: custonfiel d_10000.


http://example.com:8080/secure/admin/ConfigureCustomField!default.jspa?customFieldId=10000
http://example.com:8080/secure/admin/ConfigureCustomField!default.jspa?customFieldId=10000

JIRA should also be configured to allow remote API calls. To turn on remote API calls, first sign into JIRA
as an administrator and select Admi ni st r at i on from the header. Under Syst emselect Gener al
Confi gur ati on and then scroll down and find Edi t Conf i gur at i on. After clicking Edi t

Confi gurati on, scroll down and find Accept renpte APl call s, then select the On radio button
and click Updat e to complete the change.

Required repository properties
The following properties need to be added to the r eposi t or y section.

® project: The value must identify the project area of the repository to be used for synchronization, e.
g.
<scope>

<field id="project" val ue="COBRA"/ >
</ scope>

® proxyStorageAttribute: id of the custom field for storing proxy information, e.g.:

<proxy-storage-attribute id="attribute.jira.custom:custonfield 10000" />

® proxyStorageAttributelsSparse: must be set to true, lets Tasktop Sync know that JIRA excludes
empty custom attributes from the task data:

<proxy-storage-attribute id="attribute.jira.custom:custonfield 10000"
sparse="true"/>

Additional requirements

JIRA excludes empty custom attributes from the task data. When mapping a custom JIRA attribute, a spar
se flag must be set to true, e.g.:

<attribute key="attribute.jira.custom:custonfield 10100" sparse="true">

The above setting ensures that Tasktop Sync will detect that the value of a custom JIRA attribute has
been cleared.

The default copy attribute mapping strategy must be used when mapping a custom JIRA attribute. This
strategy, when paired with the spar se attribute, ensures that if the target custom attribute has been
excluded from the JIRA task data, then the attribute will be created.

Status caster



To map status in JIRA with workflow restrictions, a multiple submission Groovy scripted caster should be
used. An example of a multiple submission Groovy scripted caster can be found in the Tasktop Sync User
Guide.

Comments

The comment - cont ent - t ype for JIRA repositories should be set to conf | uence.

Fix/Affects Version attributes

Synchronizing the JIRA Fix/Affects Version attributes requires that the value " " must be explicitly
mapped if resetting the selection is needed. e.g:

<attri but e- mappi ng>
<attribute id="category" caster="val ue-map">
<caster-configuration>
<map>
<entry key="" val ue="Unassi gned Project in non-JIRA
repository"/>
</ map>
</ caster-configuration>
</attribute>
<attribute id="attribute.jira.affectsversions" caster="val ue- map" >
<caster-configuration>
<map>
<entry key="Unassi gned Project in non-JIRA
repository" value=""/>
</ map>
</ caster-configuration>
</attribute>
</ attri bute-mppi ng>



To use the Borland StarTeam connector with Tasktop Sync you will need to get the Borland StarTeam
connector distribution from a Tasktop Sales Engineer. Download this zip file to a convenient location on
the installation server. You will be prompted for it in the installation process.

Queries are always stored on the server, but you can create queries on either via Web client or using the
form on Tasktop Sync.
Queries are only able to return one task type, but you can run that query on any combination of projects.

Queries can return all assignable types. As delivered, Borland StarTeam has these assignable types: tasks,
change requests, requirements, and stories.

The Borland StarTeam repository login credentials used by Tasktop Sync must have Administrator
credentials.

MPX (Push)

It is not possible to run a query with StarTeam for which tasks have changed, so all tasks need to be
returned and examined for changes. However, StarTeam has a “push” feature called MPX. After you run a
guery once, then MPX will push changes to Tasktop Sync, so queries are in theory not needed. (We
recommend setting def aul t - quer y-i nt er val - m nut es to something large like 60, just to be safe.)
MPX propagates changes extremely quickly.

To use MPX, you will need to check the MPX box when you create the repository connection:



= Properties for Task Reposit_ Elﬁlg

.
Borland StarTeam Repository Settings (Tasktop Enterprise) .’.‘ t
Supports versions 2009 (11.0) and higher. “ﬁ
°
Server: starteam.example.com -
Label: StarTeam [] Disconnected
User ID: tasktopSync

Password: Save Password
~ Additional Settings

Encryption

@ No encryption

) RC4

©) RC2-ECB

) RC2-CBC

) RC2-CFB

MPX Settings
[¥] Enable MPX

[Unicast Off-site '] ’ Refresh list of profiles]

Commit Traces

Default SCM: | <no default> - [ Refresh list of SCMs |

Max. Changesets: 2

b Task Editor Settings

[%) Validate Settings [ Finish ] ’ Cancel

Borland StarTeam synchronizer.xml requirements

Required attributes and properties
Additional r eposi t ory scope fields:

® project (required): The value must identify the project area of the repository to be used for
synchronization.

The Synopsis field is mandatory.

Summary is a derived attribute. It is the first line of the Synopsis attribute, which is mandatory. This means
that you cannot create the Summary attribute directly.

Comments

You should set conment - cont ent - t ype for Borland StarTeam repositories to “text/plain”.



If you are using the Borland StarTeam Web Ul, you will probably not notice synchronizations immediately.
You should press F5 to see the changes.



CA Agile Planning and CA Clarity
Requirements Connector

This section describes how to connect to supported versions of CA Agile Planning and CA Clarity
Requirements using Tasktop’s connector.

CA Repository Configuration Requirements

This section describes changes to the CA repository that are needed to allow synchronization.

Associations Field

The associations field is required for Tasktop Sync to create an association between two synchronizing
tasks. CA objects (e.g. User Story, Issue) do not contain an association field by default. Each CA object
synchronized in Tasktop Sync, requires a custom associations field to allow task synchronization.

To create and enable the proxy association field in CA:

1.) Sign into the CA repository with a System Administrator profile

2.) Click the Set up link in the top right corner

3.) Navigate down the far left pane to the App Set up section, select Cr eat e then Obj ect s to view the
list of objects

Home CA Vision Products Dashboards Documents Reports Teams

Expand All | Colapse All .
@ quickFnd Custom Objects
Custom objects are database tables that allow yt
Force.com Home
Once you have created a custom object, you can
System Overview
Personal Setup Action Label Installed Pac
*| My Personal Information Edit 4 Acceptance Criteria mﬂ
»| Email E—
*| Import Edit & Agile Vision User CSPTr:Ch”O'O
»| Desktop Integration
¥ My Chatter Settings Edit % Approval History C7Technolo
) | CATechnolo
App Setup Edit = Backlog Filter PP
»| Customize Edit = Backlog Filter Item _CiPAP'I;:chnolo
=
Apps Edit 4 Baseline CATechnolo
- PPM
Custom Labels
Objects Edit -, BaselineDifference %’w
Packages Edit ¥ Cateqo CATechnolo
Report Types -PPM
Tabs Edit 4 Comment CATechnolo
»| Workflow & Approvals -PPM
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4.) Navigate through the list of objects to find the object that will be synchronized (e.g. User Story,

Requirement) and click on the object label to view the object
5.) Scroll down until the Cust om Fi el ds & Rel ati onshi ps section appears and click the New button

found at the top of the section to open the New Cust om Fi el d page

Custom Fields & Relationships (Wew ) Fieta Dependencies | | Set History Tracking
Action Field Label APl Name
Edit ¥ Actual Result agile1206051633__Actual_Result__c

6.) Scroll down to the Text data type and select the radio button then click next

7)) Fillout the Fi el d Label with a name similar to Taskt opSyncPr oxy ( NOTE: this name is required
for the synchronizer.xml file configuration, see the CA Synchronizer.xml Requirements for more
information), next enter 250 for the Lengt h field then click next, next and save

User Story

New Custom Field

Field Label ITasktopSyncF‘ery i

Please enter the maximum length for a text field below
Length |250

Field Name IngI.quSyncF‘mxy i

8.) Navigate back by clicking CA Vi si on Pr oduct s tab, usually found on the left side of the tab bar
9.) Hover over Adni ni strati on, select Cust om Attri but es, choose the product and object to be
synchronized and click Enabl e Attri but e, then select the custom proxy field from the drop-down list

then click Save and C ose

Agile Visien Administration

Agile Vision = Overview > Home

Organization Application c

Welcome to Aglle V|S| Users Waster Releases PWDEHYVIEWS.
Roles Products List Views Publishing
Releases Custom MVL

Sprints

Custom Aftributes,

Global Configuration
Status Mapping

Administration

Administration > Configuration > Custom Attributes

Product: ([a product [=] ) Object: (| User story =)
L -/ e U

T N\
Enable Attribute | Delete
[\ S

Enable Attribute

Figld Name: | TasktopSyncProxy 5

Saveand Close | | Save and New Cancel
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Connecting to a CA repository requires a System Administrator profile with a security token. For more
information about security tokens see the Salesforce help documentation. When entering credentials for
the repository connector, the security token must be appended to the end of your password with no
spaces or characters between the password and security token (e.g. PasswordNOtArE4LTOKEn3Jh3K).

Queries for the CA connector can only be constructed within Tasktop Sync utilizing the form queries
option. Currently, relative dates are not supported so care should be taken when scoping queries so that
the changes query does not become too large over time.

This section describes unique and notable synchronizer.xml configuration requirements for the CA
connector.

Configuration

® item-type
® |ssue
Requirement
Test Case_ c
Task_ ¢
User_Story ¢

Required Fields for User Stories, Issues, Requirements and Tasks

Summary and the proxy association field are both required fields to synchronize with CA for User Stories,
Issues, Requirements and Tasks.

Summary

The summary can be mapped through the Attribute Mapping view or by starting your synchronizer
configuration using Quick Start.

Proxy Association Storage Attribute

12


http://na9.salesforce.com/help/doc/en/user_security_token.htm

To map the custom association field created in CA, specify the pr oxySt or ageAt tri but e in synchr oni
zer.xm intherepository element. If custom field has not been created for the proxy storage
attribute in CA, refer to the CA Repository Configuration Requirements section for more information. The
property value for the pr oxySt or ageAt t ri but e uses the APl Nane for the custom proxy association
field created in CA. The APl Nane is the Fi el d Nane of the custom field with “__¢” appended to the
end (e.g. Field Name: customName API Name: customName__c). If custom association field was named Ta
skt opSyncPr oxy, the association property added to the repository element will be the same as the
example below.

<proxy-storage-attribute id="TasktopSyncProxy__c" />

Required Fields for Test Cases

Synchronizing Test Case is unidirectional from HPE Quality Center (QC)/Application Lifecycle
Management (ALM) to CA only. The following sections contain all required fields and examples of how
they can be mapped in the synchronizer.xml file. The example mappings below are for reference only as
some attributes names/labels may not be the same for your repository. It is recommended that these
fields be mapped from the Attribute Mapping view.

Summary

<attri but e- mappi ng>
<attribute id="TS NAME"' strategy="ignore"/>
<attribute id="task.comon. sunmary"/>

</ attri bute-mppi ng>

Test ID

<attri but e- mappi ng>
<attribute id="TS TEST ID' strategy="ignore"/>
<attribute id="**** Test Id_c"/>
</attribute-mppi ng>

The **** value will change depending on your CA repository, this value will be generated automatically
when using the Attribute Mapping editor

QC Project Name

The HPE QC/ALM connector requires that the project be specified for synchronization. For that reason, QC
Pr oj ect Nane is synchronized using a literal caster with the name of the HPE QC/ALM project. The
project name can be viewed from the HPE QC/ALM web Ul or from the repository URL. For example, if
your HPE QC/ALM repository URLishtt p://sone. url/ qcbi n; The_Domai n; The_Proj ect, the
literal caster will look like the example below.
<attri but e- nappi ng>

<attribute caster=""''" strategy="ignore"/>

<attribute id="ca.vision.qc.project.nane" caster="'The_ Project'"/>
</ attribute-mppi ng>

13


http://some.url/qcbin;The_Domain;The_Project

QC Folder Hierarchy

<attri but e- mappi ng>
<attribute id="TS SUBJECT" strategy="ignore"/>
<attribute id="ca.vision.qc.folder.hierarchy"/>
</ attribute-mappi ng>

Note: the folder hierarchy attribute in HPE QC/ALM is called Subj ect

Proxy Association Storage Attribute

The proxy association field for Test Case is the same as any CA object and can be specified by adding the

following property to the r eposi t or y element in the synchronizer.xml file. If you have not yet created a
custom field for the proxy storage attribute in CA, refer to the CA Repository Configuration Requirements
section for more information.

<pr oxy-storage-attribute id="TasktopSyncProxy c" />

Tasktop Sync supports one way Requirements sync only
Tasktop Sync only supports unidirectional attribute mappings for syncing from CA Requirements. This
means it is possible to synchronize changes made in CA Requirements into an outside repository, but it is

not possible to synchronize changes from an outside repository into CA Requirements. It is recommended
that the Attribute Mapping editor is used to specify attribute mappings as unidirectional.

System Administrator credentials are required

The CA repository in Tasktop Sync must use System Administrator credentials to allow Sync to perform all
operations required by CA.

Syncing Test ID for Test Case

If you are experiencing problems syncing Test ID from HPE QC/ALM to CA, a workaround is to sync Task
Key (Tasktop) from HPE to Testld in CA.

14



This section explains how to connect to supported versions of CA PPM® using Tasktop’s CA Project and
Portfolio Management Connector.

Before using Tasktop Sync for CA Project and Portfolio Management, there are a few steps to follow to
configure the CA Project and Portfolio Management server for integration with Tasktop Sync.

Create Proxy Association Attribute for CA Project and Portfolio
Management

Tasktop Sync for CA Project and Portfolio Management requires a custom attribute to store proxy
association information. Follow these instructions to create this attribute:

Log in to the CA Project and Portfolio Management web Ul as an adminstrator
Select bj ect s from the Admi ni strati on menu

Select the Task object from the list

Navigate to the At t ri but es tab

Select New from the bottom toolbar

SetAttribute IDtottsync_proxyassn

SetData TypetoString

Set Maxi mum Si ze to 100 (or greater)

Set Attri bute Nane (and Descri pti on, if desired) to an appropriate value to allow easy
identification of the purpose of the attribute

® Select Save and Return

The new attribute will not be visible in the web Ul by default and does not need to be exposed for
Tasktop Sync for CA Project and Portfolio Management to work correctly.

Install Custom NSQL Scripts

For performance reasons, and to properly support the Tasktop Sync proxy association custom field,
Tasktop Sync uses custom NSQL scripts on the CA Project and Portfolio Management server to retrieve Ta
sk details. NSQL queries are SQL-like scripts installed on a CA Project and Portfolio Management server,
and are exposed via SOAP API. The CA Project and Portfolio Management Studio Developer’s Guide
contains further information on NSQL.

15


https://support.ca.com/cadocs/7/CA%20Clarity%20PPM%2013%200%2000%20Admin%20On%20Premise-ENU/Bookshelf.html

Directions

In the CA Project and Portfolio Management web interface, navigate to Adm ni strati on -> St udi o ->
Queri es. For each of the four scripts listed in the following section, do the following:

Click the New button at the bottom of the page

Set the query ID to be the same as the name of the script (e.g. TTSyncQuery_Get Assi gnnent s)
Set the other properties (Avai | abl e for user portlets,Content Source, Category)to
the values given in the “Properties” section

Clarity PPM 2 oemreseine :

General

Query Properties: General

E Query Name hasktup Sync Query - Get Assigr x BB
B E % Query ID  TTSyncQuery_GetAssignments

Available for User Portlets

B Content Source  Customer ﬂ
Category  Project ﬂ
Description
Save and Continue Save And Return Return

B =Reguired [ =EnterOnce % = Unigue

® Copy the content in the “Source” section to the NSQL section in the web interface

Clarity PPM

® Click the Save And Ret ur n button

The queries are automatically available through the web service after saving.

16



The Scripts

TTSyncQuery_GetAssignments

Properties

® Auvailable for user portlets: true

® Content Source: Customer
® Category: Project

Source

SELECT @bel ect : DI M USER_DEF: | MPLI ED: ASSI GNVENT: A. PRUI D:

tt_Assignnentlnternal | D@
@el ect : DI M_PROP:
tt _Assi gnnent Taskl D@
@el ect : DI M_PROP:
tt _Assi gnnment Resour cel D@
@sel ect : DI M_PROP:

tt _Assi gnmrent | sUnpl anned@
@>el ect : DI M_PROP:

tt _Assi gnnment Est Pattern@

@el ect : DI M_PROP:

tt _Assi gnrent Est Max @

@sel ect : DI M_PROP:

tt _Assi gnnment PendEst Sum@

@el ect : DI M_PROP:

tt _Assi gnnment PendAct Surr@

@el ect : DI M_PROP:

tt _Assi gnnment PendSt art @

@el ect : DI M_PROP:

tt _Assi gnnent PendFi ni ish@

@el ect : DI M_PROP:

tt _Assignhnment Start @

@sel ect : DI M_PROP:

tt _Assi gnment Fi ni sh@

@el ect : DI M_PROP:

tt _Assi gnnent St at us@

@el ect : DI M_PROP:

tt _Assi gnnent Act Sum@

@sel ect : DI M_PROP:

tt _Assi gnnent ActThru@

@el ect : DI M_PROP:

tt _Assi gnnent Est Sum@

@el ect : DI M_PROP:

tt _Assi gnment Wm@

@el ect : DI M_PROP:

tt _Assi gnnent Ext ensi on@

@el ect : DI M_PROP:
tt _Assignnment Sli ceStatus@

@sel ect : DI M_PROP:

t t _Assi gnment CurveSt at us@

@el ect : DI M_PROP:
tt _Assi gnnent Rol el D@

@el ect : DI M_PROP:
tt _Assi gnent Team D@

USER_DEF:

USER_DEF:

USER_DEF:

USER _DEF:
USER _DEF:
USER_DEF:
USER _DEF:
USER _DEF:
USER_DEF:
USER_DEF:
USER _DEF:
USER _DEF:
USER_DEF:
USER_DEF:
USER _DEF:
USER _DEF:
USER_DEF:

USER_DEF:

USER_DEF:

USER_DEF:

USER_DEF:

| MPLI ED: ASSI GNMVENT: A. PRTASKI Dt

| MPLI ED:

| MPLI ED:

| MPLI ED:

| MPLI ED:

| MPLI ED:

| MPLI ED:

| MPLI ED:

| MPLI ED:

| MPLI ED:

| MPLI ED:

| MPLI ED:

| MPLI ED:

| MPLI ED:

| MPLI ED:

| MPLI ED:

| MPLI ED:

| MPLI ED:

| MPLI ED:

| MPLI ED:

| MPLI ED:
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ASSI GNMVENT:

ASSI GNMVENT:

ASS| GNMVENT:

ASSI GNMVENT:

ASS| GNMVENT:

ASS| GNMVENT:

ASSI GNMVENT:

ASS| GNMVENT:

ASSI GNMVENT:

ASSI GNMVENT:

ASS| GNMVENT:

ASSI GNMVENT:

ASS| GNMVENT:

ASS| GNMVENT:

ASSI GNMVENT:

ASS| GNMVENT:

ASSI GNMVENT:

ASSI GNIVENT:

ASS| GNMVENT:

ASSI GNMVENT:

A

>z o oz r »r r r > x rr P P P P> P> P> P> P> P

PRRESCURCEI D

. PRI SUNPLANNED:

. PRESTPATTERN:

PRESTMAX:

. PRPENDESTSUM

. PRPENDACTSUM

. PRPENDSTART:

. PRPENDFI NI SH:

. PRSTART:

. PRFI NI SH:

. PRSTATUS:

. PRACTSUM

. PRACTTHRU:

. PRESTSUM

PRVWDM

. PREXTENSI ON:
. SLI CE_STATUS:

. CURVE_STATUS:

ROLE_| D:

. TEAM | D:



@>el ect : DI M_PROP: USER_DEF:

t t _Assi gnment Cr eat edDat e@

@vel ect : DI M_PROP: USER_DEF:

t t _Assi gnment Cr eat edBy@

@el ect : DI M_PROP: USER DEF:

tt _Assi gnnent Last Updat edDat e@

@>el ect : DI M_PROP: USER_DEF:

tt _Assi gnmrent Last Updat edBy @

@bel ect : DI M_PROP: USER_DEF:

tt _Assi gnnent Act Cost Curve@

@>el ect : DI M_PROP: USER_DEF:

tt _Assi gnnent Act Cost Sun@

@bel ect : DI M_PROP: USER_DEF:
@bel ect : DI M_PROP: USER_DEF:

tt _Assi gnnent Resourcel\lane@

FROM PRASSI GNVENT A
: SRM RESOURCES R
WHERE A PRRESOURCEID = R ID
AND @ LTER@

TTSyncQuery_GetLookup

Properties

® Available for user portlets: true
® Content Source: Customer
® Category: Productivity

Source:

SELECT @SELECT:

@BELECT:

LOOKUP_TYPE@

@SELECT:

LOOKUP_CODE@

@BELECT:

L OOKUP_ENUM@

@BELECT:
@SELECT:

LOOKUP_LANG@

FROM
VWHERE

CWN_LOOKUPS_V L
@ LTER@

TTSyncQuery_GetProjects

Properties

® Auvailable for user portlets: true
® Content Source: Customer
® Category: Project

Source:

DI M_PROP: USER_DEF:
DI M_PROP: USER_DEF:

DI M_PROP: USER_DEF:
DI M_PROP: USER_DEF:

| MPLI ED:
| MPLI ED:
| MPLI ED:
| MPLI ED:
| MPLI ED:
| MPLI ED:

| MPLI ED:
| MPLI ED:

DI M USER_DEF: | MPLI ED: RESOURCE: L. | D:
DI M_PROP: USER_DEF:

| MPLI ED:
| MPLI ED:
| MPLI ED:

| MPLI ED:
| MPLI ED:
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ASSI GNMVENT:

ASSI GNMVENT:

ASS| GNMVENT:

ASSI GNMVENT:

ASS| GNMVENT:

ASS| GNMVENT:

ASSI GNMVENT:
ASS| GNMVENT:

RESCURCE: L.

RESCURCE: L.

RESOURCE: L.
RESCURCE: L.

ar > > r r > P

. CREATED_DATE:
. CREATED_BY:
. LAST_UPDATED_DATE:

. LAST_UPDATED_BY:

ACTCOST_CURVE:

ACTCOST_SUM

.PRID:tt_Assi gnnent | D@
. UNI QUE_NAME:

LOOKUP_| D@
RESOURCE: L.

LOOKUP_TYPE:

L OOKUP_CODE:

L OOKUP_ENUM

NAME: LOOKUP_NAVE@
LANGUAGE_CODE:



SELECT @SELECT: DI M USER_DEF: | MPLI ED: PRJ: P. PRI
@SELECT: DI M_PROP:

tt_Project External | D@

@SELECT: DI M_PROP:
@SELECT: DI M_PROP:
@SELECT: DI M_PROP:

tt_Proj ect GU DELI NES@

@SELECT: DI M_PROP:

t t _Project DEPARTI\/ENT@

, @SELECT: DI M_PROP:
@SELECT: DI M_PROP:

tt _Project USERTEXTG@
tt_Proj ect USERTEXT7@
, @BELECT:
, @BELECT:
, @BELECT:
, @ELECT:
, @BELECT:
, @BELECT:
tt_Proj ect TRACKMODE@

, @SELECT: DI M_PROP:
@SELECT: DI M_PROP:

tt _Proj ect CHARGECODEI D@

@SELECT: DI M_PROP:

t t _Project SPONSOREDBY@

@SELECT: DI M_PROP:

t t _Project REQJESTEDBY@

@SELECT: DI M_PROP:

tt _Proj ect REQUESTEDTI NE@

@SELECT: DI M_PROP:

tt _Proj ect APPROVEDTI ME@

@SELECT: DI M_PROP:

tt _Proj ect USERTEXTl@

@SELECT: DI M_PROP:

tt _Proj ect USERTEXT2@

@SELECT: DI M_PROP:

tt _Project USERTEXT3@

@SELECT: DI M_PROP:

tt _Proj ect USERTEXT4@

, @SELECT: DI M_PROP:
@SELECT: DI M_PROP:

tt _ProjectFl SCALSTART@

@SELECT: DI M_PROP:

tt _Proj ect USERTEXT5@

@SELECT: DI M_PROP:

t t _Project PCTCOVPLETE@

@SELECT: DI M_PROP:

tt _ProjectPRRORI TY@

@SELECT: DI M_PROP:

tt _Proj ect CLOSEDTI I\/E@

@SELECT: DI M_PROP:

tt _Proj ect USERNANVE@

@SELECT: DI M_PROP:

tt _Proj ect SI ZEADJ UST@

@SELECT: DI M_PROP:

tt _Proj ect SI ZEADJ UST(]\I@

@SELECT: DI M_PROP:

DI M_PROP;
DI M_PROP:
DI M_PROP:
DI M_PROP:
DI M_PROP:;
DI M_PROP:

USER_DEF:

USER_DEF:
USER_DEF:
USER_DEF:
USER_DEF:

USER_DEF:
USER_DEF:

USER_DEF:
USER_DEF:
USER_DEF:
USER_DEF:
USER_DEF:
USER_DEF:
USER_DEF:

USER_DEF:
USER_DEF:

USER _DEF:
USER_DEF:
USER_DEF:
USER _DEF:
USER_DEF:
USER _DEF:
USER _DEF:
USER _DEF:

USER_DEF:
USER_DEF:

USER _DEF:
USER_DEF:
USER_DEF:
USER_DEF:
USER_DEF:
USER _DEF:

USER_DEF:

| MPLI ED:
| MPLI ED:
| MPLI ED:
| MPLI ED:
| MPLI ED:

| MPLI ED:
| MPLI ED:

| MPLI ED:
| MPLI ED:
| MPLI ED:
| MPLI ED:
| MPLI ED:
| MPLI ED:
| MPLI ED:

| MPLI ED:
| MPLI ED:

| MPLI ED:

| MPLI ED:

| MPLI ED:

| MPLI ED:

| MPLI ED:

| MPLI ED:

| MPLI ED:

| MPLI ED:

| MPLI ED:
| MPLI ED:

| MPLI ED:

| MPLI ED:

| MPLI ED:

| MPLI ED:

| MPLI ED:

| MPLI ED:

| MPLI ED:
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PRJ:
PRIJ:
PRJ:
PRJ:
PRJ:

PRIJ:
PRJ:

PRJ:
PRJ:
PRJ:
PRJ:
PRJ:
PRJ:
PRJ:

PRJ:
PRIJ:

PRJ:

PRJ:

PRJ:

PRJ:

PRJ:

PRJ:

PRJ:

PRJ:

PRJ:
PRIJ:

PRJ:

PRJ:

PRJ:

PRJ:

PRJ:

PRJ:

PRJ:

U UTUU VU

T

UU UUTUUUT T

T U

oY) ) o

)

T O

. PRFORVAT: t t
. PRFI SCALSTART:

rtt_Projectlnternal | D@
PREXTERNALI D:
. PRNAME: tt _Pr oj ect Name @
.PRUD: tt_ProjectU D@
. PRGUI DELI NES:
. PRDEPARTMENT:
. PRVERSI ON: tt _Pr oj ect VERSI ON@
. PRUSERTEXT®6:
. PRUSERTEXT7:
. PRBUDGET: tt _Proj ect BUDGET@

. PRSTART: tt _Proj ect START@

PRASOF: tt _Proj ect ASOF@
PRFI NI SH: tt_Proj ect FI Nl SH@
PRCPMTYPE: tt _Proj ect CPMTYPE@
PRTRACKMODE:

. PRI SOPEN: tt _Proj ect | SOPEN@
PRCHARGECODE!I D:

. PRSPONSOREDBY:

. PRREQUESTEDBY:

. PRREQUESTEDTI ME:
. PRAPPROVEDTI ME:
. PRUSERTEXT1:

. PRUSERTEXT2:

. PRUSERTEXTS3:

. PRUSERTEXT4:

_Proj ect FORVAT@

. PRUSERTEXTS:

. PRPCTCOVPLETE:

. PRPRI ORI TY:

. PRCLOSEDTI ME:

. PRUSERNANE:

. PRSI ZEADJUST:

. PRSI ZEADJUSTON:



@ELECT: DI M_PROP:
tt _Proj ect STARTI MPOSED@
@SELECT: DI M_PROP:
tt _Proj ect FI NI SH MPOSED@
@BELECT: DI M_PROP:
tt _Proj ect BASESTART@
@ELECT: DI M_PROP:
tt _Proj ect BASEFI NI SH@
@SELECT: DI M_PROP:
_Proj ect BASETI NE@
, @BELECT: DI M_PROP:
, @BELECT: DI M_PROP:
, @ELECT: DI M_PROP:
tt_Proj ect DESCRI PTI ON@
@BELECT: DI M_PROP:
tt PrOJectISACTIVE@
@ELECT: DI M_PROP:
tt _Proj ect ASSGN POO_@

tt

FROM PRPRQIECT P

, I NV_I NVESTMENTS |
VWHERE P.PRRD = 1.1D
AND @l LTER@

TTSyncQuery GetTasks

Properties

USER _DEF:
USER_DEF:
USER_DEF:
USER _DEF:
USER_DEF:
USER_DEF:
USER_DEF:
USER_DEF:
USER_DEF:

USER_DEF:

® Auvailable for user portlets: true

® Content Source: Customer
® Category: Project

Source

SELECT @bel ect : DI M USER_DEF: | MPLI ED: TASK:
| MPLI ED:
| MPLI ED:

, @el ect : DI M_PROP:

@sel ect : DI M_PROP:
tt _TaskCreat edDat e@

@el ect : DI M_PROP:
tt _TaskEvBcwpOvr @

@sel ect : DI M_PROP:
tt _TaskEvCal cMet hod@

@el ect : DI M_PROP:

USER_DEF:
USER_DEF:

USER_DEF:

USER_DEF:

USER_DEF:

tt _Taskl sOQpenFor Ti neEntry@

@el ect : DI M_PROP:
tt _TasklsPctDirty@

@el ect : DI M_PROP:
tt _TaskLast Cal cRun@

@el ect : DI M_PROP:
tt _TaskLast Rul eRunl D@

@Bel ect : DI M_PROP:
tt _TaskLast Updat edBy@

@sel ect : DI M_PROP:
tt _TaskLast Updat edDate@

@el ect : DI M_PROP:
tt _TaskCal cEsti nat e@

USER _DEF:
USER_DEF:
USER_DEF:
USER _DEF:
USER_DEF:

USER_DEF:

| MPLI ED:
| MPLI ED:
| MPLI ED:
| MPLI ED:
| MPLI ED:
| MPLI ED:
| MPLI ED:
| MPLI ED:
| MPLI ED:

| MPLI ED:

| MPLI ED:

| MPLI ED:

| MPLI ED:

| MPLI ED:

| MPLI ED:

| MPLI ED:

| MPLI ED:

| MPLI ED:

| MPLI ED:
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PRJ:
PRJ:
PRJ:
PRJ:
PRJ:
PRJ:
PRJ:
PRJ:
PRJ:

PRJ:

TUU U T

V)

. PRSTART| MPCSED:

. PRFI' NI SHI MPCSED:

. PRBASESTART:

. PRBASEFI NI SH:

. PRBASETI ME:

PRMODBY: tt _Proj ect MODBY@

. PRMODTI ME: tt _Pr oj ect MODTI VE@
. PRDESCRI PTI ON:

.1 S_ACTI VE;

. ASSGN_POQL:

T.PRID: tt_tasklnternal | D@

TASK: T.
TASK: T.

TASK:

TASK:

TASK:

TASK:

TASK:

TASK:

TASK:

TASK:

TASK:

T
T
T
T
T.
T
T
T
T

CREATED BY: tt_TaskCreat edBy@
CREATED_DATE:

. EV_BCW_OVR
. EV_CALC_NMETHOD:
.1'S_OPEN_TE:
.1'S_PCT_DI RTY:

LAST CALC RUN:

. LAST_RULE_RUN_| D:
. LAST_UPDATED_BY:

. LAST_UPDATED_DATE:

. PRCALCESTI MATE:



tt

tt
tt

tt

tt

tt

tt
tt
tt
tt

tt

tt

tt
tt

tt

tt

tt

FROM

@el ect : DI M_PROP:
@el ect : DI M_PROP:

_TaskChar geCodel D@

@el ect : DI M_PROP:
@el ect : DI M_PROP:

_TaskEar | yFi ni sh@

@el ect : DI M_PROP:

_TaskEarlyStart @

@el ect : DI M_PROP:

_TaskExt er nal | D@

@el ect : DI M_PROP:
@el ect : DI M_PROP:

_TaskQui del i nes@

@Bel ect : DI M_PROP:
_TasklsCritical @

@sel ect : DI M_PROP:
@el ect : DI M_PROP:
@el ect : DI M_PROP:
@el ect : DI M_PROP:
_Taskl sM | est one@

@el ect : DI M_PROP:
@sel ect : DI M_PROP:

_Taskl sUnpl anned@

@el ect : DI M_PROP:

_TaskLat eFi ni sh@

@el ect : DI M_PROP:

_TaskLateStart @

@el ect : DI M_PROP:

_TaskMet hodExt | D@

@Bel ect : DI M_PROP:
@el ect : DI M_PROP:

_TaskPct Conpl ete@

@el ect : DI M_PROP:
@el ect : DI M_PROP:
tt _TaskProj ect | nt ernal | D@
@el ect : DI M_PROP:
_TaskShort Nanme@

@sel ect : DI M_PROP:
@el ect : DI M_PROP:
@el ect : DI M_PROP:
_TaskTot al Fl oat @

@el ect : DI M_PROP:
@el ect : DI M_PROP:

_TaskUser Text 1@

@Bel ect : DI M_PROP:
@Bel ect : DI M_PROP:
_TaskWhsSequence@

@sel ect : DI M_PROP:
@el ect : DI M_PROP:
@el ect : DI M_PROP:
@sel ect : DI M_PROP:

_TaskProxyAssn@

@el ect : DI M_PROP:
tt _TaskProj ect Ext ernal | D@

PRTASK T
PRPRQIECT P

USER_DEF:
USER_DEF:

USER_DEF:
USER_DEF:

USER_DEF:
USER_DEF:

USER_DEF:
USER_DEF:

USER_DEF:
USER_DEF:
USER_DEF:
USER_DEF:
USER_DEF:

USER_DEF:
USER_DEF:

USER_DEF:
USER_DEF:
USER_DEF:

USER_DEF:
USER_DEF:

USER_DEF:
USER_DEF:

USER_DEF:

USER_DEF:
USER_DEF:
USER_DEF:

USER_DEF:
USER_DEF:

USER_DEF:
USER_DEF:

USER_DEF:
USER_DEF:
USER_DEF:
USER_DEF:

USER_DEF:

| MPLI ED:
| MPLI ED:

| MPLI ED:
| MPLI ED:

| MPLI ED:

| MPLI ED:

| MPLI ED:
| MPLI ED:

| MPLI ED:
| MPLI ED:
| MPLI ED:
| MPLI ED:
| MPLI ED:

| MPLI ED:
| MPLI ED:

| MPLI ED:

| MPLI ED:

| MPLI ED:

| MPLI ED:
| MPLI ED:

| MPLI ED:
| MPLI ED:

| MPLI ED:

| MPLI ED:
| MPLI ED:
| MPLI ED:

| MPLI ED:
| MPLI ED:

| MPLI ED:
| MPLI ED:

| MPLI ED:
| MPLI ED:
| MPLI ED:
| MPLI ED:

| MPLI ED:
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TASK:
TASK:

TASK:
TASK:

TASK:

TASK:

TASK:
TASK:

TASK:
TASK:
TASK:
TASK:
TASK:

TASK:
TASK:

TASK:

TASK:

TASK:

TASK:
TASK:

TASK:
TASK:

TASK:

TASK:
TASK:
TASK:

TASK:
TASK:

TASK:
TASK:

TASK:
TASK:
TASK:
TASK:

TASK:

44-4 d44 A4 HA-44 A A4 H44 4 A4 A4 A4 HdA-4-44 A4 A4 4 44 H-4 44

PRCATEGORY: tt _TaskCat egor y@
PRCHARGECODEI D

. PRDURATI ON: tt _TaskDurati on@
. PREARLYFI NI SH:

. PREARLYSTART:
. PREXTERNALI D:

.PRFINISH: tt_TaskFi ni sh@
. PRGUI DELI NES:

. PRI SCRI Tl CAL:

. PRI SFI XED: tt _Taskl sFi xed@
. PRI SKEY: tt Taskl skey@

PRI SLOCKED: tt _Taskl sLocked@

. PRI SM LESTONE:

. PRI STASK: tt _Taskl sTask@
. PRI SUNPLANNED:

. PRLATEFI NI SH:

. PRLATESTART:

PRVETHODEXT]I D:

PRNAME: tt _TaskNanme@
PRPCTCOVPLETE:

.PRPRICRITY:tt _TaskPriority@

PRPRQIECTI D

PRSHORTNAME:

.PRSTART:tt_TaskStart @
. PRSTATUS: tt _TaskSt at us@
. PRTOTALFLQAT:

PRU D: tt_TaskU D@

. PRUSERTEXT1:

PRWBSLEVEL: tt TaskWsLevel @
PRVWBSSEQUENCE:

PRWDM tt TaskWim@

.VBS_NNBSEQ tt_TaskWsNnbSeq@
.WBS PARSEQ tt_TaskWhsPar Seq@

CUSTOM TTSYNC_PROXYASSN:

P.

PREXTERNALI D:



VWHERE T.PRID

AND
AND

ODF_CA_TASK CUSTOM

CUSTOM | D
T. PRPRQJECTI D

P. PRI D
@l LTER@

Connecting to the CA Project and Portfolio Management Repository

Tasktop Sync must be configured to connect to the CA Project and Portfolio Management Repository
through the Tasktop Sync Repository manager.

Add the CA Project and Portfolio Management repository to the Task Repositories view:

Right click in the pane of the Task Repositories view and select Add Task Repository... as
shown:

& console | €] Error Log | I Problems | 5 Progress @ Task Repositories £

4 = Tasks
G,{ Local
4 = Bugs
D, Tasktop Sync Support

I Add Task Repository...
Delete Repository Delete
fors Update Repository Configuration F5
Disconnected
New Task...
New Query...
Open Repaository Task... Ctrl+Alt+Shift+F12

Synchronize All Tasks

Choose CA Project and Portfolio Management from the list

Fill in the specifics for your repository in the Add Task Repository dialog. Click the Val i dat e
button after filling out the fields to validate that Tasktop Sync can connect to your repository

Select No when Tasktop Sync asks you if you would like to add a new query to the repository.

Create Initialization and Changes Queries for CA Project and Portfolio
Management

After the previous step, Tasktop Sync has been configured to connect to your CA Project and Portfolio
Management server and you are ready to create the changes and initialization queries. Please consult the
configuration section on creating queries for details on the purpose of the queries you will be creating.
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® Right click on your CA Project and Portfolio Management repository;
® Clickon New Query. . .
[i' Add Task Repository...

# Delete Repository Delete
Update Repository Configuration F5

Disconnected

7 New Task...

Mew Query...

[ Open Repository Task... Ctrl+Alt+Shift+F12
“] Synchronize All Tasks

Refresh Schema Locally
% Refresh Schema from Repository

Properties Alt+Enter

® Select either the Single-Project or Multi-Projects Query type (depending on whether your
synchronization should span over multiple projects)
® Select your project area(s) from the list in the resulting dialog

Enter a title for the query and select Fi ni sh;
Repeat the previous steps if a different project is required for the initialization query.

Create a Task Mapping for CA Project and Portfolio Management

The final step in configuring Tasktop Sync for CA Project and Portfolio Management is to create a task
mapping. Please consult the Task Synchronization Configuration section for detailed instructions on
creating and editing task mappings.

Required Properties

Once the mapping is created, CA Project and Portfolio Management specific properties must be defined.
The list of required properties is listed below. Properties are defined in the following way:

Double-click on the task mapping;

Navigate to the Over vi ewtab;

On the CA Project and Portfolio Management side of the page, find the Pr operti es section and
select Add;

Select the property name from the Name dropdown;

Fill in the Val ue field and click CK;

Save the mapping by pressing Ctrl+S or by clicking the Save icon in the top right corner

Recommended repository properties: .
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® proxyStorageAttribute: The value must identify an attribute that will be used to store proxy
information. The id of this attribute must be ttsync_proxyassn.

Required Attribute Mappings

The Ext er nal Task | Dattribute must be set on all tasks being synchronized between CA Project and
Portfolio Management and the other repository. See the Attribute Limitations section for more details. A
mapping for the Ext er nal Task | Dattribute is required in order for this attribute to be set when
Tasktop Sync synchronizes a new task into CA Project and Portfolio Management. The Ext er nal Task
| Dattribute must be unique in the CA Project and Portfolio Management project. It is recommended to
map External Task ID to the | Dor Key attribute in the other repository. This mapping must be one way
from the other repository into CA Project and Portfolio Management and must use the Initialize mapping
strategy. In the synchronizer.xml file, the mapping should look similar to this:

<attri but e- mappi ng>

<attribute id="task.comon. key" strategy="initialize"/>

<attribute id="id" strategy="ignore"/>
</ attri bute-mppi ng>

Thel nt ernal Proj ect | Dattribute must be mapped in all task mappings. A value mapper can be
used. The | D portion of the project attribute refers to the project’s internal ID (a number), not the external
ID.

With the CA Project and Portfolio Management connector for Tasktop Sync, you can synchronize
attributes from an artifact on another system to the assignments of a task in Project and Portfolio
Management, using a scripted attribute handler.

Handling Task Assignments in a Scripted Attribute Handler

In your attribute handler script, task assignments are represented as “assignment” attributes. By reading
and modifying these assignment attributes you can manipulate the assignments of a task.

All assignment attributes have attribute type t askt op. t ype. assi gnrment and have IDs following the
pattern t askt op. assi gnnent - [ nunber ] . An assignment attribute has two child attributes with IDs t a
skt op. assi gnnent . assi gnee and t askt op. assi gnnent . est i nat e, which, for Project and
Portfolio Management, represent the resource ID and Estimated Time To Complete (ETC) of the task
assignment, respectively.

To read or modify an existing task assignment you must get the assignment attribute for that assignment,
and read or modify the values of itst askt op. assi gnnent . assi gnee and t askt op. assi gnnent .
est i mat e child attributes.
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To create a new task assignment you must create a new assignment attribute. Create a new task attribute
under the root attribute of your task, and set its type to t askt op. t ype. assi gnment . Then create two
child attributes with IDs t askt op. assi gnnment . assi gnee and t askt op. assi gnnent . esti mat e
under that attribute, and set their values to whichever resource ID and ETC you like.

For an example of a scripted attribute handler for Project and Portfolio Management task assignments,
see Synchronizing CA Project and Portfolio Management with Microsoft Team Foundation Server: Task
Assignments.

Limitations and Other Notes on Task Assignments

® The Project and Portfolio Management connector cannot delete task assignments
® Removing an existing assignment attribute in your attribute handler script will have no effect
® Project and Portfolio Management does not allow multiple task assignments to have the same
resource
® If your attribute handler script creates a new assignment attribute and sets the value of its t as
kt op. assi gnment . assi gnhee child attribute to the same value as an existing assignment
attribute, this will result in a synchronization error
® The ETC for a task assignment is shown in the Project and Portfolio Management web application in
hours, but is represented internally in milliseconds
® Your attribute handler script may need to convert a source estimate value to milliseconds
before setting it on the t askt op. assi gnnent . esti mat e attribute

A note about TasktopSync 2.8 users

We have changed how assignments are represented in TasktopSync 3.0.0, so if you have used assignment
synchronization with a previous build, do ensure that your mappings and scripts follow the structure
above.

The Project and Portfolio Management connector will use the following default date values:

Tasks

® A newly created task’s Start and Finish dates will default to Today if not set

Task Assignments

® A task assignment’s Start and Finish dates will be set to its task’s Start and Finish dates
® A task assignment’s Start date will be set to Today if its task’s Start date is not set
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® A task assignment’s Finish date will set to its Start date plus its Estimated to Complete if its task’s
Finish date is not set

Feature Limitations

Tasktop Sync for CA Project and Portfolio Management only supports synchronizing Task objects. All
tasks within the specified project will be synchronized. As there is no way to comment on a Task object
within CA Project and Portfolio Management, comment synchronization is not supported. Currently,
attachment synchronization is also not supported.

Attribute Limitations

External Task ID

Tasktop Sync for CA Project and Portfolio Management requires that the Ext er nal Task | Dattribute
be set on all tasks. In the CA Project and Portfolio Management web Ul, this attribute is called | D. Tasks
without an Ext er nal Task | Dwill not be synchronized and will end up in the error queue. Tasktop
Sync for CA Project and Portfolio Management cannot change Ext er nal Task | Dafter initialization.
However, Ext er nal Task | Dmay be changed via the CA Project and Portfolio Management web Ul
without causing problems. See Required Attribute Mappings section above for recommendations for the E
xt ernal Task | Dattribute mapping.

Status and % Complete

The St at us and % Conpl et e attributes are linked in CA Project and Portfolio Management. Changes to
the % Conpl et e will be ignored if the task is not in the St ar t ed state. % Conpl et e will be setto O if a
task is moved to the Not St art ed state; it will be set to 100 if the task is moved to the Conpl et ed
state. If this behavior is not enforced on the attributes from the other repository, mapping both St at us
and % Conpl et e will lead to unexpected results. In this case, it is recommended to either not map the %
Compl et e attribute or to map it one-way from CA Project and Portfolio Management into the other
system. The St at us attribute can then be mapped normally.

Read-only Attributes

The Last Updat ed Dat e attribute and the | nt er nal Task | Dattributes can be read from CA
Project and Portfolio Management, but values cannot be set into them.

Custom Attributes

Custom attributes are not supported by Tasktop Sync for CA Project and Portfolio Management. Only
standard attributes, those defined in a default CA Project and Portfolio Management installation, can be
mapped.
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HPE QC /7 ALM Connector [pre Sync 3.5]
Connecting to HPE QC /7 ALM

Adding a Repository

Before queries can be created over HPE QC / ALM requirements and defects, you must first set up an
HPE QC / ALM Task Repository in the Task Repositories View:

HPE QC / ALM

1. Open the Task Repositories View — from the Window menu select Window > Show View > Other >
Mylyn > Task Repositories

2. In the view that opens, click the Add Task Repository button in the view toolbar.

3. In the wizard that opens, select ‘HPE QC / ALM 11’ from the list of available repositories and click

Next.
= Properties for Task Repository 5 |t

HPE QC { ALM 11 Repository Settings

Supports HPE QC / ALM 10, HPE QC / ALM 11 =
Server: http://server.com:8080/qchin -
Label: HPE QC / ALM 10 and HPE QC / ALM 11 ["] Disconnected
User ID: user

Password: [ Save Password
Domain  DEFAULT -
Project Example_Project =

} Additional Settings

b Task Editor Settings

4. In the server field, enter the HPE QC / ALM web service URL. For example, http://server.com:8080
/qchbin

5. Choose a label for the repository and enter your credentials. Check the Save password box if you
want the password to persist between workbench sessions.

6. Click Refresh to download the list of domains and projects available on the server, and select the

Domain and Project that you would like to connect to (if you already know the Domain and Project,

you can just enter the URL in the format http://server:8080/qcbin;Domain;Project). If you want to

connect to more than one project, you will have to repeat this process to set up a repository for

each one.

Press the Validate Settings button to confirm that the settings are correct.

8. Press the Finish button

~N

HPE Agile Manager
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1. Open the Task Repositories View — from the Window menu select Window > Show View > Other >

Mylyn > Task Repositories

In the view that opens, click the Add Task Repository button in the view toolbar.

3. In the wizard that opens, select ‘HPE QC / ALM 11’ from the list of available repositories and click
Next.

4. In the server field, paste the complete HPE Agile Manager URL from your web browser. For
example, https://server.com/agm/webui/alm/saas_alm_123456789/Main/apm/@6Cn5d/?
TENANTID=123456789#home

5. Choose a label for the repository and enter your credentials. Check the Save password box if you
want the password to persist between workbench sessions.

6. Press the Validate Settings button to confirm that the settings are correct.

7. Press the Finish button

N

Queries — Bringing your HPE QC /7 ALM
requirements and defects into the Task List

A query is the primary means to get HPE QC / ALM tasks (Requirements and Defects) into the Task List.
To manually add a new query, click the New drop down (the arrow beside the button) in the Task List
toolbar, or right click in the Task List view and select New > Query. Choose the HPE QC / ALM repository
that you just created when prompted to choose a repository.

N
= New Repositary Query ] B [

Select a repository -
Add new repositories using the Task Repositories view.

If a repository is missing it does not support the requested operation.

[d_HPE QC / ALM 10 and HPE QC / ALM 11

’ [§ Add Task Repository... ] ’ & Install More Connectors..,

@ < Back Next > Finish

After you select your HPE QC / ALM repository and click Next, you are presented with a choice of which
kind of query to create. You can query Defects or Requirements, by choosing from a list of Favorite
gueries.
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Fd [y
= Edit Repository Query @M
—

Enter query parameters

If attributes are blank or stale press the Update button, —
Title:  All My Defects
@) Defect
() Requirement
type filter text =Y

| Private/All My Defects |
Private/Cross with requirement types
Private/Requirernent Cross Query
Public/QA Bug Verification
Public/QA Team Member - My Fixed and Rejected defects
Public/R&D Team Member - Defects Assigned to Me

Refresh From Repository
® ot [

Favorite queries are server side queries that can be brought into your personal Task List. Navigate the
available queries on the HPE QC / ALM repository and choose the query you wish to include in your task
list, then click the Finish button. The query is added to your Task List and matching tasks appear nested
under the query.

HPE QC /7 ALM Connector — Requirements
for Sync

This section explains how to connect to supported versions of HPE QC / ALM using Tasktop’s HPE QC /
ALM connector.

HPE QC / ALM Installation requirements

If the server version is HPE QC / ALM v10 or older, the HPE QC / ALM Connectivity add-in needs to be
installed. To download the add-in, go to

http://qualityCenterHostAndPort/qchin/addins.html

(where gualityCenterHostAndPort should be similar to hpal m exanpl e. com 8080).

HPE QC / ALM Repository Configuration requirements

Server Version
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When creating repositories for HPE QC / ALM, a number of options are available in the “Server Version”
dropdown under the “Additional Settings” area. If the server version is HPE QC / ALM 11 and above, the
server version should be set to either Aut onati c orHPE QC / ALM 11 ( REST).

Note that HPE QC / ALM 11. 5 is not a supported server version (however HPE QC / ALM 11. 52 is
supported).

"’v Properties for Task Repository (S |
HPE QC / ALM 11 Repository Settings (Tasktop Enterprise)
Supports HPE QC / ALM 10, HPE QC / ALM 11, and Agile Manager ==
Server: http://example.com:8080/qcbin o=
Label: HPE QC/ ALM 11 Disconnected
User ID: administrator
Password: s | Save Password

Domain DEFAULT = Refresh

Project Test i

~ Additional Settings

Server Version: [Automatic -]

Automatic -

Locale: HPE QC / ALM 11 (REST) L
HPE QC / ALM 11 (Mative) Sl =
Comment Parsing Strategy: ISR O) @
HPE QC / ALM 10 (Native) -
Maximum number of items retfEved per request: pLI
Update requirement folder structure during repository configuration update.
Hide entity kind prefix in Task List view
Show Requirements Hierarchy in Task List
(% Validate Settings Cancel

If using HPE QC / ALM 10 or below, thenthe HPE QC / ALM 10 ( Renbt e) option must be selected.
The remote client is a special Sync-specific connector which uses HPE QC / ALM'’s native client running in
a remote process to work around memory-leak issues in the native client.

In Sync, the HPE QC / ALM 10 (Nati ve) option is disabled by default due to instability. If Tasktop
Sync is started up with this repository setting, it will likely crash periodically due to a bug in the HPE QC /
ALM native client. It can still be force-enabled by adding the property showNat i veC i ent to the
TasktopSync.ini file.

Comment Parsing Strategy

There are three comment parsing strategies to choose from: None (no comment parsing strategy), Stri ct,
and Leni ent . These strategies represent the procedure in which the HPE QC / ALM multi-comment field
is separated into individual comments for synchronization to another repository. The St ri ct comment
parsing strategy is the default for Tasktop Sync.

It should be noted that enabling or disabling comment parsing in the repository settings page does not
enable or disable comment synchronization in any related task mappings, and similarly enabling or
disabling comment synchronization in a task mapping will not enable or disable comment parsing. This
means that tasks which have comments which fail to parse will cause errors even when their task mapping
has comment synchronization disabled, when comment parsing is enabled in the repository settings page.
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No comment parsing strategy

When no comment parsing strategy is specified, HPE QC / ALM tasks will not have comments for
synchronization.

If comment synchronization is disabled, one can still synchronize the multi-comment field from HPE QC /
ALM to arich text field in the other system.

Strict comment parsing strategy

This strategy employs the delimiter of twenty-five consecutive underscore characters used by HPE QC /
ALM to separate the body of text into individual comments. Comments synchronized using this strategy
will use the text following the “:” character as the text body for the synchronized comment. Text
preceding this character will be used as comment metadata to discern the comment author and creation
date. If the creation date cannot be parsed from the comment metadata, comment creation dates will
show as Jan 1 1970 00:00:00 GMT.

Failure to parse the text body into individual comments will result in an error and stop synchronization of
this artifact.

Lenient comment parsing strategy

As with the St ri ct parsing strategy, the Leni ent strategy separates the text body into comments using
the aforementioned delimiter. This strategy also attempts to parse the comment metadata preceding the
“” character of each comment to identify the comment author and creation date. Failure to parse this
metadata results in using the entire comment text between delimiters (including malformatted comment
metadata) as the body of text for each comment. In this case, comments have creation dates of Jan 1
1970 00:00:00 GMT. Because the comment author will not be known in the event of a metadata parsing
failure, the person mapping must be configured with a valid default user.

Issues with synchronization will arise if malformed comments that have been created in HPE QC / ALM
are corrected after they have been posted. The corrected comment will be recognized as a new comment
and synchronized to the proxy repository. The malformed comment still present in the proxy repository
will then be synchronized back to HPE QC / ALM. Correcting the duplicate malformatted comment in HPE
QC / ALM will result in the repetition of these same actions by Tasktop Sync. Malformatted comments
created in HPE QC / ALM while using the Leni ent strategy will always be present in both repositories.

Switching strategies from Lenient to Strict

Malformatted comments that had been synchronized while using the Leni ent strategy will cause
synchronization failures after switching to the St ri ct comment parsing strategy.

Comments

In the r eposi t ory section, coment - cont ent -t ype should be settot ext/ htmi .
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HPE QC / ALM have a unique approach to comment handling. One (HTML formatted) field is used to
store the entire list of comments, separated by:
Each of those individual comments follow one of the following formats: user Narre dat e:

comment Text oruser Ful | Name <user Name>, date: comment Text . (Please note that the second
format is shown based on how it displays in the web UI. Internally, the comment is stored with the angle
brackets encoded to & t ; and &gt ; . If comments are added outside of the Ul (via scripting, for example),
the encoded format should be used.)

It is important to know that in order for successful comment synchronization, Tasktop Sync makes the
following assumptions to be able to parse comments reliably based on the examples above:

® splitting the entire comment field by results in the list of
comments
® each comment starts with a comment header, which can be either
® aHPE QC/ ALM “user name” (which is unique), followed by a comma, followed by a date,
followed by a colon, or
® auser’s full name (not unique), followed by the user name (unique) in angle brackets, followed
by a comma, followed by a date, followed by a colon
® after this individual comment header, everything else is interpreted as the comment’s text (including
HTML formatting and line breaks)

Note that user name and user’s full name cannot contain “’, ‘<’, or ‘>’ characters.

Examples of Valid HPE QC / ALM Comments

tasktop, 01/01/1970: test comrent

U ysses User <n02910>, 1/1/1970: test coment

Examples of Invalid HPE QC / ALM Comments

1/ 1/1970: test conmrent
t est Comment
tasktop 1/1/1970: test comment

tasktop, 1/1/1970 test comment
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On rare occasions, HPE QC / ALM can send invalid HTML. The most common example is that a comment
contains HTML tags which are not closed, or closing tags which are lacking a corresponding opening tag.

We understand that it can and will happen that users intentionally or accidentally break this implicit HPE
QC / ALM comment formatting contract and thus Tasktop Sync will fail to parse comments. Tasktop is
collecting data on those failures and is improving comment parsing results constantly.

If a comment parsing error occurs, check for unusual characters and formatting, based on the examples of
valid comments above. If there are no obvious issues, please contact support@tasktop.com and provide us
with the full error log entry (which should contain the comment text) and we will investigate further.

Additionally, HPE QC / ALM might return invalid HTML with unclosed tags. Tasktop Sync comment
parsing will fail on those occasions and provide enough details to manually fix this in the HPE QC / ALM
web Ul. Usually the best approach to fix this is to delete the text before and after the unclosed tag (to
effectively cause deletion of the faulty tag) and then rewrite that text in the web Ul.

Another related issue is formatting information being stripped when HPE QC / ALM comments are
synchronized to another system. This often occurs due to HTML tags being inserted in the comment
header. This causes the parser to strip all of the tags from the comment in order to differentiate the
comment metadata and comment body. Removing the tags in the comment header may cause the
formatting to be synced to the other system.

If a failure related to HPE QC / ALM Comment handling occurs, check the error details for further
information on which comment caused the problem. Most of the time the issue can be resolved by fixing
the comment in the web UI.

® The HPE QC / ALM 11 sync works natively with a REST client only. For HPE QC / ALM version 10,
you need to download the HPE QC / ALM Connectivity Add-in.

® HPE QC / ALM allows the editing of defects with stale data. That is if sync modifies a defect that
has been synchronized with incoming changes from another repository, and the user then edits the
same task without refreshing the client, the incoming changes would be overridden.
The HPE QC / ALM connector does not support IPv6
Favorite filters containing dates must use “yyyy-mm-dd” date format.
Using a form based (local) query on user names with spaces is hot supported. Use a favorite (server
stored query) instead.
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® The following characters are not supported as part of attachment file names, all other characters
including whitespace are valid: \ /: *?"<>| % +
® The HPE QC / ALM connector does not support 0 byte attachments.

| keep getting a message like “Unable to login. Please validate
credentials” but | can login on the web. How do | connect?

If you are running HPE QC / ALM on WebLogic or WebSphere, there could be a problem with the server
configuration that will interfere with your ability to use the connector. Basic Authentication is enabled by
default in WebLogic and WebSphere and intercepts the REST API authentication requests there and
needs to be switched off for the application domain. For WebLogic this is done by inserting this parameter

<enforce-val i d-basi c-aut h-credenti al s>f al se</ enf orce-val i d-basi c- aut h-
credenti al s>

within this section

<security-configuration></security-configuration>

of the config.xml of the domain that HPE QC / ALM is configured on. Note that this is reflected in the
HPE QC / ALM REST APIs help documentation in the general limitations section.

| keep getting a Security Alert dialog about certificate revocation. How
do I solve this?

Security Alert E3
7 Revocation infarmation for the sacunty cedtiicate for thes zite iz not
¥ available. Do youwant to proceed?

Yes I Mo View Centificate

This alert can be disabled by turning off the checks for revoked certificates:
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| General I Security I Privacy I Content I Connections I Programs | Advanced l

Settings

Enable automatic image resizing
[7] Play animations in webpages™®
[7] Play sounds in webpages
[7] show image download placeholders
Show pictures
ﬁ Security
[] allow active content from CDs to run on My Computer®
[] allow active content to run in files on My Computer®
[7] allow software to run or install even if the signature is invi
=] Block unsecured images with other mixed content

hedk for publisher's certificate revocation
Chedk for server certificate revocation™
| Check for signatures on downloaded programs
| [7] Do not save encrypted pages to disk |
I T

*Takes effect after you restart your computer

l Restore advanced settings ]

Reset Internet Explorer settings

Resets Internet Explorer's settings to their default

condition,

You should only use this if your browser is in an unusable state.

Ok ][ Cancel ][ Apply ]

Open the Internet Options and uncheck both Check for publisher's certificate revocation
and Check for server certificate revocati on. After a restart of the computer, the Security

Alert should not happen anymore.
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This section explains how to connect to supported versions of IBM® Rational DOORS Next Gen™ using
Tasktop’s IBM Rational DOORS Next Gen Connector.

Connecting to the IBM Rational DOORS Next Gen Repository

Tasktop Sync must be configured to connect to the IBM Rational DOORS Next Gen Repository through
the Tasktop Sync Repository manager.

Add the IBM Rational DOORS Next Gen repository to the Task Repositories view:

® Right click in the pane of the Task Repositories view and select “Add Task Repository...” as shown:

B Conscle Ql Error Log | [ Problems | 53 Progress @ Task Repositories ©%
a [= Tasks

D,{ Local
4 = Bugs

U, Tasktop Sync Support

[ Add Task Repository...
Delete Repository Delete
Update Repository Configuration F5
Disconnected
New Task...
New Query...
Open Repository Task... Ctrl+Alt+Shift+F12

Synchronize All Tasks

® Choose IBM Rational DOORS Next Gen Repository from the list

® Fill the repository information into the fields of the “Add Task Repository” dialog. Click the “Validate
Settings” button after filling out the fields to validate that Tasktop Sync can connect to the
repository.

® Select no when Tasktop Sync asks to add a new query to the repository.

Create Initialization and Changes Queries for IBM Rational DOORS
Next Gen
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After the previous step, Tasktop Sync has been configured to connect to the IBM Rational DOORS Next
Gen server. Now, the changes and initialization queries can be created. Please consult the configuration se
ction on creating queries for details on the purpose of the queries.

® Right click on the IBM Rational DOORS Next Gen Repository.
® Click on “New Query...”:
[i' Add Task Repository...

¥ Delete Repository Delete
Update Repository Configuration F5

Disconnected

A

MNew Task...
Mew Query...
Open Repository Task... Ctrl+ Alt+Shift+F12

& & Lk

Synchronize All Tasks

Refresh Schema Locally
Refresh Schema from Repository

5

Properties Alt+Enter

® Select query type:
“. Edit Query o [ 23]

Choose query type i
[ 7A)

Select from the available query types

@i

Create query from a collection

P ——

Query from folders

® Select the project area from the top of the dialog.
® Select the folders to include in the query.
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® Select the appropriate Modi f i ed option. It is recommended to select Today for the changes query

and Al | for the initialization query.
%, Edit Query o [ 5] E]

Enter query parameters ///_
Create query from folders A

Title: Feature Tasks

)

Project Area: [ Requirements

Folders:

a [T = Requirements
4 [J] = Features
> (= Advanced Features
(= Basic Features
[7] = Men-Functional Requirements
[7] &= Terms and Glossaries
[F] & User Story Elaborations

Modified: &) All @ ) This Week (0 Last Week () Last Hour

@:‘ Mext = Finizsh ] [ Cancel

® Repeat the previous step to add the initialization query to Tasktop Sync.

Query from a collection

® Select the project area from the top of the dialog.
® Select a collection for the query.
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® Select the appropriate Modi f i ed option. It is recommended to select Today for the changes query
and Al | for the initialization query.
“. Edit Query o [ 23]

Enter query parameters /f)’_
| [ &

Create query from a collection

Title: Basic Features and Elaberations

Project Area: | Requirements - |

Collections:

type filter text

—|[_E| 6508: Basic Features and Elaborations

Modified: @ All Today This Week Last Week Last Hour

Refresh
'C?:l < Back Mest > FEinish ] | Cancel

® Repeat the previous step to add the initialization query to Tasktop Sync.

Required attributes and properties

Additional r eposi t or y properties:

® project (required): The value must identify the project area of the repository to be used for
synchronization.

® proxyStorageAttribute (required): The value must identify an attribute that will be used to store
proxy information.

Setting up the proxyStorageAttribute property

Note: these instructions assume a task mapping exists for IBM Rational DOORS Next Gen and HPE QC /
ALM.

® Create a new custom field in the IBM Rational DOORS Next Gen project:
® Asan administrator, navigate to Manage Project Properties in the IBM Rational DOORS Next
Gen web UL
® Under the Artifact Types tab, with Requirements highlighted under the Artifact Types list,
select Add Attribute in the Artifact Attributes list.
® Click New Attribute from the resulting pop up.
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® In the Create New Attribute dialog box, name the new attribute and set its data type to String
and click OK.

® Select the newly created attribute in the Add Attribute dialog box and click OK. The new
attribute should now appear in the list under the Artifact Attributes header.

® Click Save.

® Set custom field to be the proxy storage field in Sync:
® Open the task mapping. Click the Rational DOORS Next Gen Schema tab at the bottom of the
mapping and refresh the schema. The newly created attribute should now appear in the
schema.

® Right-click on the new attribute in the Attributes list and select Copy ID.
® Click the Overview tab at the bottom of the mapping.
® In the IBM Rational DOORS Next Gen Properties section in the Overview, click Add.
® Select proxyStorageAttribute from the Name dropdown.
® Paste the copied attribute ID into the Value field and click OK.
® Save the mapping by clicking the Save icon in the top right corner.
Folder Sync

The IBM Rational DOORS Next Gen connector supports synchronization of the folder of a requirement to
and from a mapped repository. Folder Sync allows the containment of a requirement to be synchronized
such that the requirement will reside in a folder (or container) of the same name and structure in the
mapped repository.

Preparing for Folder Sync

In order to synchronize folders, ensure that the structure and names of each folder in IBM Rational
DOORS Next Gen matches the target repository. Folder structure must be configured prior to
synchronization. For example, folder structures for IBM Rational DOORS Next Gen and HPE QC / ALM
could be set up as follows:
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Feqguirementz  Edit  “iew Favoriies  Analysi
Ef &1 8 & T~ [ B 0 &~
| No Filter Defired

AT W ot Hame 4
- < Requirements
= Features
+ ] Advanced Features
[ | Basic Features
] Gloszaries and Terms
[ Mon-Functional Bequireme...
] Uszer Stary Elaborations

Limitations

Artifact Types

Each artifact type requires a separate mapping since not all attributes are common to all artifact types,
even within the same project. If the artifact type of a requirement is changed, it will fall under a new
mapping. Only the attributes common to both mappings will continue to sync properly. Artifact type

should not be a mapped attribute.

Artifact Format

Tasktop Sync only supports Text format requirements.

Folder Names

® The IBM Rational DOORS Next Gen connector for Tasktop Sync does not support projects with
folders whose names contain the characters “&”, “<”, or “>”. Attempting to synchronize
requirements from such a project will result in an error. However, synchronizing requirements from
another project without such folders, on the same server, will work as expected.

Folder Sync

® Folder names may not contain the character “/” when Tasktop Sync is configured to synchronize

folders.
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Unsupported IBM Rational DOORS Next Gen Features

Tasktop Sync does not support synchronization of the following for IBM Rational DOORS Next Gen:

® Comments
® Attachments

Unsupported Basic Types

Tasktop Sync does not support mappings for attributes of the following IBM Rational DOORS Next Gen
types:

Float

Time

DateTime

Duration

Multi-select Enumerations

Attribute Sync Limitations

® Primary Text attribute (main description field) can only be synchronized one-way from IBM Rational
DOORS Next Gen to the target repository.
® HTML tags are removed from standard text fields that are not rich text (e.g. The “Summary” field)

Summary with special characters appears encoded (Rational DOORS Next
Gen Versions 4.0.4 and 4.0.5)

Due to a defect on the Rational DOORS Next Gen versions 4.0.4 and 4.0.5, requirement summaries
containing special characters (e.g. an & character) will appear encoded (e.g. &amp) when synchronized to
another ALM system. This problem is resolved in versions 4.0.6 and up.

For more information, please see jazz.net ticket 83692 .
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This section explains how to connect to supported versions of IBM Rational Team Concert using Tasktop’s
IBM Rational Team Concert SDK Connector.

Tasktop Sync requires that the IBM Rational Team Concert client plugins are available to connect to these
repositories. An account on jazz.net is needed to download the required plugins. The plugins will be
available as a p2 repository zip file. Download the version that exactly matches the server version. For
example, version 4.0 requires you to download Rational Team Concert v4.0 p2 repository. Unzip these
plugins to a location on the hard drive. This location will be entered during the installation of Tasktop Sync.

1. Permissions

® The account that will be used by Tasktop Sync requires a Rational Team Concert Developer License
as Tasktop Sync cannot operate under a Rational Team Concert Contributor License.

® Further, ensure that the account used by Tasktop Sync is assigned process roles which are granted
all permissions listed under Work Items in both the Project Configuration and the Team
Configuration. It is also recommended that the Tasktop Sync user is granted all permissions
attributed to a basic user process role.

Connecting to the Rational Team Concert Repository

Tasktop Sync must be configured to connect to the Rational Team Concert Repository through the
Tasktop Sync Repository manager.
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Open up the Task Repositories view by pressing Ctrl+3 and typing in “Task Repositories”. Select
“Task Repositories - Mylyn” from the Views section as shown:
Task Re|

Previous Choices  [{J) Task Repositories - Mylyn

Views @ Task Repositories - Mylyn

Add Task Repository...

Add Task Repository... (Bugzilla (supports 3.0 and later)
Add Task Repository... (HP Quality Center 10 and HP Al
Add Task Repository... (Local Task Repository)

Add Task Repository... (Rational Team Concert)

Mark Task Read (Alt+Shift+R)

Mark Task Read and Go Te Mext Unread Task (Alt+Shift
Mark Task Read and Go Te Previous Unread Task (Alt+!
Open Cheat Sheet (Create a task repository query) - Op
Show In (Task Repositories)

Show View (Task Repositeries) - Shows a particular viev

Commands

@
@
@
@
@
@
@
@
@
@
@

Press ‘Ctri=3' to show all matches,

Right click in the pane of the Task Repositories view and select “Add Task Repository...” as shown:

B Conscle (@ Error Log (Ij Problems (53 Progress (@ﬂ Task Repositories £3
4 [ Tasks
02 Local
4 [= Bugs
D_ Tasktop Sync Support

ﬁ Add Task Repository...

3 Delete Repository Delete

=4 Update Repository Configuration F5
_— Disconnected

MNew Task...
New Query...

Open Repository Task... Crl+Alt+Shift+F12

Synchronize All Tasks
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® Fill in the specifics to your repository in the Add Task Repository dialog. Click the validate button
after filling out the fields to validate that Tasktop Sync can connect to your repository. An example
repository may look as follows:

%, Add Task Repository... X
Rational Team Concert Settings (Tasktop Enterprise)
Enter connection details for your Rational Team Concert repository u

Server: https:// «com:9443/cem -
Label: RTC Repository Disconnected
User ITx demo

Password: =% V| Save Password
» Additional Settings

¥ Proxy Server Configuration

b Task Editor Settings

{ L}Q Validate Seﬁingsﬂ | =< Back Einish | ‘ Cancel

® By default only the projects the authenticated user is a Member of are supported (the Administrator
role is not sufficient). This ensures that the repository configuration update remains as small as
possible in a large environment. To display all project areas on the server, disable the “Only support
project areas the user is a member of” option in the Advanced Settings:

Password:

« Additional Settings

| Only support project areas the user is a member of.

® Select no when Tasktop Sync asks to add a new query to the repository.

Create Initialization and Changes Queries for IBM Rational Team
Concert

After the previous step, Tasktop Sync has been configured to connect to your Rational Team Concert
server and the changes and initialization queries should be configured as well. Please consult the
configuration section on creating queries for details on the purpose of the queries you will be creating.

Both the initialization and changes queries should be created on the Rational Team Concert Query server.
Please check the Rational Team Concert documentation for details on how to create queries. Once these
queries have been created, add these queries to Tasktop Sync.

® Navigate to the Task Repositories view either by clicking on Task Repositories, or using Ctrl+3 and
typing in “Task Repositories”, selecting the appropriate view;
Right click on the Rational Team Concert Repository;
Click on “New Query...”;
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® Select the project area from the drop down at the top of the resulting dialog;
® Select the changes query created above from the list of available queries;
2 Edit Query = | ]

Rational Team Concert - Stored Queries

Enter a title I\ )

Title:  Blocked Work Items

Project Area: | RtcTestArea - |

-
Closed created by me

Closed subscribed by me

My current work

Mew unassigned

Open Adoptions

Open assigned to me

Refresh

\£) < Bac Jext = Finish ] | Cancel

® Repeat the previous 3 steps to add the initialization query to Tasktop Sync.

Edit IBM Rational Team Concert synchronizer.xmi

The final step in configuring Tasktop Sync for Rational Team Concert is to make the appropriate edits to

the synchronizer.xml configuration file. To complete these edits, follow the instructions in the synchronizer
Xxml section. Please note:

® The URL you use in the repository element of your synchronizer file must match exactly the URL
you specified when creating your repository above.

The names of changes/initialization queries specified in the synchr oni zer . xm file must also

match exactly the names for these queries above. Tasktop Sync will not function correctly if they do

not match and will report errors, for example, that it cannot find a given query.

The value of the pr oj ect property in the synchroni zer. xm file must be the name of the

desired project area. Using the UUID, or any identifier other than the project area’s name, will result

in Tasktop Sync failing to generate a task schema for your Rational Team Concert repository.

® Forconment -content -type,use"text/plain; mar kup=RTCRi chText".

The summary of the Rational Team Concert specific additions to the synchr oni zer . xm configuration
is listed below.

Required attributes and properties
Additional r eposi t ory scope fields:

® project (required): The name of the project area of the repository to be used for synchronization.
(Be sure to use the project area’s name, and not its UUID)
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® itemType (required): Must match the Rational Team Concert Workltem type ID (e.g. task, defect,
etc), not the user-visible name for that item type.

Additional r eposi t or y fields:

® <proxy-storage-attribute id=""> (optional): If using a custom proxy storage attribute the
desired attribute ID must be placed within nanme="".

® <proxy-storage-attribute id="" sparse="true"> (optional): If using a custom proxy
storage attribute with IBM Rational Team Concert this property must add spar se="t r ue" for

Tasktop Sync to use the configured custom proxy storage attribute.

Issues with Simultaneous Log-in

Tasktop Sync may not function correctly if the same Rational Team Concert user is logged on to Tasktop
Sync and the Rational Team Concert web Ul simultaneously.
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Microsoft Team Foundation Server
Connector [pre Sync 4.2]

Installation Requirements

The Microsoft Team Foundation Server connector requires the Microsoft Virtual Studio Team Explorer
Everywhere plugin and the Tasktop Team Foundation Server Sync Connector. When you run the
installation program, one of the pages of the dialog will prompt you to install the Team Foundation Server
Sync Connector. Be sure that you check the box for I nstall TFS Sync Connector (requires
the installation of Mcrosoft Team Expl orer Everywhere) on this page. If you do not
check this checkbox on installation, and later decide that you do want a Team Foundation Server
connector, you will need to reinstall Tasktop Sync.

@ Installation Configuration Options =] ® ==
Taskiop Syne Installation Options ”~, Tasktep
Flease select the configurations you require. b Sync

Please select relevant configuration options

Install 3z a Windows Service

Listed below are Sync connectors that required third-party software to function. Please
select any of these optional Sync connectors you would like to be installed.

H] Install IBM Rational Team Concert Sync Connector {requires the installation of
Rational Team Concert Client)

f;[rlsiall Microsoft Team Foundation Server Sync Connector (requires the |

< Back ]I Mext = ][ Cancel

The next page will explain where to download the Team Explorer Everywhere plugin:
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&> TFS p2 Repository Location EI = @
Team Foundation Server , Tasktep

Flease select the directory where the Team Foundation Server P2 ‘ s P=1'
repasitory is located. J 1%

To configure Tasktop Sync for TFS, please select the directory where the TFS P2
repasitory has been extracted. You can download the required TFS repositary from the
following link:

Download for TFS 12.0.0

Repository Directory: | l:l

< Back |[ Mext = ] | Cancel

For Area pathandlteration path attributes, the value is a hierachical path, e.g. “Tasktop\Tasktop
Sync\Sprint 7\Iteration 3”. Most other vendors' repositories use individual attributes for the values in the
path (e.g. project\product\sprint\iteration"). In such cases, you will probably want to write a Groovy caster
to pull apart the iteration path and push it into multiple attributes. You will then need to fuse multiple
attributes into one iteration path in the other direction.

Comments

You should use comment - cont ent -t ype="t ext/ pl ai n" for Microsoft Team Foundation Server
repositories.

Proxy Storage Attribute

The use of the pr oxySt or ageAt t ri but e setting is recommended for Microsoft Team Foundation
Server repositories. If not specified, a special hyperlink is stored on TFS work items to store the proxy
association.

There are three ways to add work item fields to Team Foundation Server:

® Editing the XML (see MSDN );

49


http://msdn.microsoft.com/en-ca/library/vstudio/dd695793.aspx

® Using witadmin (see MSDN );
® Using the Team Foundation Server Power Tools Process Editor (2012 version linked)(as
recommended by MSDN );

We recommend using the Process Editor.
Follow these steps to add the attribute with the Process Editor:

Ensure the Visual Studio Power Tools are installed (Tools -> Process Editor entry will be present)
Open Visual Studio.

Go to Tools -> Process Editor -> Work Item Types -> Open WIT From Server.

Select desired collection, project and type.

In Fields tab, create new St ri ng field

(Optional) To see the field in the Team Foundation Server Ul, go to Layout tab and add it to the
layout.
%] Del

S e o

L«
NEEREREREREER

4

Set the proxy storage field writeable to only a specific set of users

The proxy storage attribute field can be configured to be read-only for most users but a certain group.
There are two strategies to do this: either a certain user group is granted exclusive permission to write to
the field, or a certain user group is forbidden from writing to the field.

Allow only one group to write the proxy storage field

<Fi el dDefinition name="proxyWrl" refnanme="proxy.url" type="String">
<READONLY not="[d obal ]\ Project Collection Administrators" />
</ Fi el dDefi ni ti on>

This is the field definition that needs to be set in the WorkltemTemplate. To set this up using the Power
Tools mentioned above, simply double click the proxy storage field, change to the RULES tab and add a
new rule READONLY, with the NOT condition set to the user group you want to have write access.
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Work Item Type

Name IEug

Description  [Diesciibes 2 divergence between requted and actuzl behaviar, 2nd tacks the work done o carrect the d
Fields | Lagout | wiorktiow |

[ New 2 Edt X Delete

Hame | Field Type | RefMame
ssigned To Shing System Assigned]
“woik Item Type Stiing System.wWorkltem
Crested Date DateTime System CreatedD.
Created By Sting System Createdby
Description PlainT st System Descritio
Histoy em Histoy
Fislated e Relatedl i
System| || Fieid Definiion - Fulss | | FosoftvsTs T
Repast| 1 tew 7 £t X oo T Y -
State Ch Hare s
Activaten Far |\ j E
Adtivatel Not:  [[Glabal\Project Collecion Adminstatars =
Resolver 5.C
Resolver ?E
Resalver ls.c
Closed [ ls.c
Closed B ls.c
Prictiy ls.c
Severly ls.c
Stack A lsc
Integratic | Yiew ML View ML Concel |58
Fourd In Sting Mioroso L WaTS B

b | prowli

Forbid one specific group from writing to the proxy

You can also set the rule to FOR, and enter a specific user group which should not be allowed to write the
field (while all other groups are able to). The set up is similar to above, just using the first of the two rule
properties (FOR).

<Fi el dDefiniti on name="proxyUrl" refnane="proxy.url" type="String">
<READONLY f or="[ d obal ]\ PROXY_READ ONLY" />
</ Fi el dDefini tion>

User permissions required for Tasktop Sync

The user used for Tasktop Sync should have at least the default contributor rights. The recommended
permission group is “ProjectAdministrator”.

The following screenshots show the project level and collection level permissions that are recommended.
Refer to the TFS help documentation for additional details on permission settings.

Project Level Permissions
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Permissions kdembers kdember of

The default project tearm,

Create test runs

Delete tearn project

Delete test runs

Edit project-level inforrmation
Fanage test configurations
FManage test ervvironrments
YWiew project-level information

Wiewy te st runs

Inherited allow
Mot set
Inkerited allow
Mot set
Inkerited allow
Inherited allow
Allowy

Inherited allowe

Collection Level Permissions
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Permissions hermber of

Administer build resource permissions Mot set
Adrinister Project Server integration Mot set
Adrinister shelved changes Mot set
Adrinisterworkspaces Mot set
Alter trace settings Mot set
Create aworkspace Inherited allowe
Create new projects Mot set
Delete tearn project Mot set
Delete tearn project collection Mot set
Edit collection-level information Mot set
bake requests on behalf of others Mot set
hanage build resources Mot set
Manage process termplate Mot set
Manage test contrallers Mot set
Trigger ewvents Mot set
Use build resources Mot set
Wiew build resources Inherited allow
Wiew collection-lewvel information Inherited allow

Wiew systerm synchronization information Mot set

Microsoft Team Foundation Server Queries
for Synchronization

With Microsoft Team Foundation Server, if you change a query, you will need to restart Tasktop Sync
before the change in the query takes effect.

With most connectors, we recommend that you create named queries on the repository server-side. For
Team Foundation Server, that is mandatory; you are not able to create queries using a Tasktop Sync form.
You can use the Team Foundation Server Web Ul, Visual Studio, or the Eclipse (not Tasktop) Team
Foundation Server plug-in. See the appropriate documentation for how to create a query.

Be careful with the name: the name will need to match the name in synchr oni zer . xm exactly. We
recommend you use a hame with three parts: “Tasktop Sync”, the repository name, and a description of
what is returned, e.g. “Tasktop Sync - Cobra Project TFS - Recently Modified Defects”.
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Microsoft Team Foundation Server
Synchronization Legal Requirements

There are specific legal licensing requirements that Microsoft requires when synchronizing data from
Team Foundation Server. This does not affect your technical ability to synchronize, it affects your legal right
to synchronize. Customers are required to ensure that their licenses with Microsoft cover their intended

synchronization use.

Microsoft Team Foundation Server
Connector Known Limitations

® The Descri pti on field in Microsoft Team Foundation Server does not support HTML or any other
rich text format. If you are synchronizing from an attribute which allows HTML or rich text
formatting, the descriptions will not look the same in the two repositories.

® Currently, IPv6 is not supported for the Team Foundation Server connector.

® The userld and display name of a user have to be unique within the team project. Submitting a user
field or comment with a user whose userld or display name is not unique will result in an error.

® Editing rich text (html) fields on a work item using Mozilla Firefox will result in unsupported html
and formatting being removed during synchronization.

® Custom Person fields are treated as string attributes in the connector, and no option (list of people
to choose from) is available. The API declares such fields no different than custom string fields.
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Mozilla Bugzilla Connector

The Mozilla Bugzilla Connector allows you to view, modify, share, and synchronize tasks from a Bugzilla
repository, all within Tasktop.

Connecting to Bugzilla

To connect to a Bugzilla repository, select “Add Task Repository” from the view menu in the Task
Repositories View. In the Add Task Repository wizard, select Bugzilla and click “Next”. On the following
wizard page, enter the URL of your Bugzilla repository, and, if your Bugzilla repository requires log-in
credentials, de-select the “Anonymous” check box and enter your credentials. Click “Validate Settings” to
confirm your credentials, then click “Finish” to finish connecting to Bugzilla.

= Add Task Repositary... A E@g
Select a task repository type ~
You can connect to an existing account using one of the installed connectors.

@ Borland StarTeam

| Bugzilla (supports 3.6 and later)

€A CA Agile Vision and CA Praduct Vision

"% Gerrit Code Review (supports 2.3 and later)

= HPE QC/ ALM and Agile Manager

ﬂﬁ] Microsoft Team Foundation Server (supports TFS 2010 and higher)
@ Mingle Repository

| 0 Mock Repository (for unit tests)

M Rally

(o) Rational Team Concert (Requires RTC Synchronization Rules)
i‘j Rational Team Concert (SDK)

0 Synergy Repository

2 Trac (supports 012 and later through Web and XML-RPC)

’ & Install More Connectors...

< Back Next > Finish
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= Add Task Repository... | =] = |

Bugzilla Repository Settings -
Supports Bugzilla 3.0 - 4.0

Example: https://bugs.eclipse.org/bugs (do not include index.cgi)

Server: http://repository.com:8080/project e
Label: Bugzilla Repository [] Disconnected
User ID: John.developer@tasktop.com [] Anenymous
Password:;  FFrses Save Password

} Additional Settings

» Http Authentication

» FProxy Server Configuration
» Task Editor Settings

Create new account  Change account settings [¥] Validate on Finish
[ Validate Settings | [ < Back Mext > [ Enish ][ cancel

Creating Queries

To create a new query on your Bugzilla repository, visit the Task List View, open the “New” menu, and
select “New Query”. The Bugzilla connector provides two ways to specify a query: using a query form, or
providing an existing query URL.

2 New Query (s[E] = ]
Select a repository =
If a repository is missing it does not support the requested operation.

EI_- Bugzilla Repository
EI_- Eclipse.org
EI_- Tasktop Enterprise Support

’ [ Add Task Repository... ] ’ &ﬂ Install More Connectors...

@ < Back Next » Finish
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Choose query type e
Select from the available query types.

@ Create query using form

(7) Create query from existing URL

@ <Back || Nexts ||  Einish

Creating Queries Using the Query Form

To create a new Bugzilla query using a form, select “Create query using form” and click “Next”. Use the
form page to specify your query. You can search for words in tasks' summaries, search by the people
related to tasks, such as the owner or reporter, and search by task attributes such as Product or
Component. To see more task attributes to search by, click on “More Options”. When you are satisfied

with your query, enter a title for it and click "Finish."

Enter query parameters [ _C-I

Title: Developer's Improve Ta sksi

Summary: Improve * |contains all of the -
Email: developer@tasktop.com -
Owner [“|Reporter [ CC [T Commenter [] QA Contact

Product: Component: Status: Severity:
Taskto UNCOMFIRMED || blocker ~
Immm NEW [ || eritical 3
Weather Tracker ASSIGMED major

RFOPENED 7 | narmal S
» More Options
} Boolean Charts (Advanced)
Clesr Fields
@ Next > [ Enish  |[ cancel

Using an Existing Query URL
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If you have already created a query using the Search feature in Bugzilla’s web interface and you wish to
use that query with the Bugzilla Connector, select “Create query from existing URL” and click “Next”. Copy
and paste the URL for the Bugzilla Search from your web browser into the “Query URL” field of the

wizard, give your query a title, and click "Finish.”

( = Edit Query [ [ B ]

Create query from URL —~

Enter the title and URL for the query

Query Title:  Developer's Improve Tasks
ificBorder=relevance+ descBibug_status=__open_ &product=&content=improve

Query URL

Finish ] ’ Cancel

Further Help

For further help with the Mozilla Bugzilla Connector, try the following resources:

® Mylyn Bugzilla Connector Help Documentation
® Mylyn Bugzilla Connector FAQ
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Serena Business Manager Connector [pre
Sync 4.1]

This document explains how to connect to Serena® Business Manager using Tasktop’s Serena Business
Manager Connector.

Connecting to the Serena Business Manager Repository

The Serena Business Manager connector must be configured to connect to the Serena Business Manager
Repository through the repository manager.

Add the Serena Business Manager repository to the Task Repositories view:

® Right click in the pane of the Task Repositories view and select Add Task Repository... as shown:

& Console (@ Error Log fﬁ Problems (53 Progress (@ Task Repositories %
a = Tasks
02 Local
4 [= Bugs
ﬂ_— Tasktop Sync Suppert

ﬁ Add Task Repository...

3 Delete Repository Delete

=4 Update Repository Configuration F5
_— Disconnected

New Task...

New Query...

Open Repository Task... Ctrl+Alt+Shift+F12
Synchronize All Tasks

® Choose Serena Business Manager [pre Sync 4.1] from the list:

'eoe® Add Task Repository...

Select a task repository type
You can connect to an existing account using one of the installed connectors.

3 Artifacts Mock Connector

# Atlassian JIRA

) GitHub Issues

=HPE QC / ALM

(23 IBM Rational Requirements Composer
HJama

) New IBM Rational Team Gongcert
8l Polarion ALM

1 Rally

S Serena Business Manager

S

S Serena Dimensions RM

= ServiceNow Service Desk

I ThoughtWorks Mingle

[ VersionOne

4 Zendesk

BN [ cancel
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® Fill in the specifics for your repository in the Add Task Repository dialog. Click the Validate button
after filling out the fields to validate that the connector can connect to your repository. An example
repository may look as follows:

%, Add Task Repository.. L@ﬂ_hj

Serena Busi Manager Repository Settings C
Settings can be verified by clicking the Validate Settings button. b ,

Server: http://myserenaserver.com -

Label: Serena Disconnected
| UserlID: user
Password: /| Save Password
» Proxy Server Configuration
b Task Editor Settings

‘ 5 Validate Settings| | < Back lext > Finish ‘ | Cancel

® Select No when asked if you would like to add a new query to the repository.

After the previous step, Tasktop Sync has been configured to connect to your Serena Business Manager
server and you are ready to create the changes and initialization queries. Please consult the configuration s
ection on creating queries for details on the purpose of the queries you will be creating.

For the Serena Business Manager connector, queries are based on reports saved to the Serena Business
Manager repository. To be used for a query, the report must contain the title and last modified date fields.

Note that these fields are identified by the standard database field names; the labels do not need to match
the standard labels for these fields.

® Right click on your Serena Business Manager repository;
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® Click on New Query...
ﬁ Add Task Repository...

# Delete Repository Delete
Update Repository Configuration F5

Disconnected

MNew Task...

Mew Query...

Open Repository Task... Ctrl+Alt+5hift+F12
Synchronize All Tasks

& B L&Dy

Refresh Schema Locally

&

Refresh Schema from Repository

Properties Alt+Enter

® Select your solution from the list in the dialog;

% e I i)
Busi Manager - Stored reports C
Select one of the stored reports N ’

Title:

Available selutions:

[ALM Projects -
ALM Projects

Change Request Management
Defects

Dev Change Requests

Dev Packages

Dev Tasks

Incident Management

Products and Cemponents

testApp3

Built-In: All Active Items I am the Primary Owner

Built-In: All Active Items I am the Secondary Owner

Built-In: All Active Iterms I Own

Built-In: All Active Items I Submitted

Built-In: All Active Unowned ftems

Built-In: All Contacts

Built-In: All Inactive Iters

Built-In: All Inactive Items I am the Primary Owner -

@ <Back | Nea> |[ Ensh ][ Cancal
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® Select your report from the list of reports in that solution;
[ edit Query - (STl

Serena Business Manager - Stored reports

Select one of the stored reports C.,

Title: AllIssuesI Own

Available selutions:

[Issue Defect Management ']

Stored reports:

All Issues in Deme Project
All Issues in Manual Testing Project

9]

| |AllIssues With Reject Count > 0

Il Assigned Issues Meeding Time Estimates

| Built-In: (All Tables) All Active tems Tam the Primary Owner b
Built-In: (All Tables) All Active Items [ am the Secondary Owner

| Built-In: (All Tables) All Active Items I Own

Built-In: (All Tables) All ltems I am the Primary Owner

Built-In: (All Tables) All ltems T am the Secondary Owner I
Built-In: (All Tables) All ltems I Own

Built-In: All Active Items

Built-In: All Active Iterns I am the Primary Owner
Built-In: All Active Items [ am the Secondary Owner

m
—

Built-In: All Active Iterns I Own
Built-In: All Active Items I Submitted

|

@j < Back Mest = Finish ] [ Cancel

® Enter a title for the query and select Finish.

Create Proxy Association Attribute for Serena Business Manager

In the next step, Tasktop Sync for Serena Business Manager will require a custom attribute to store proxy

association when using the attribute-based proxy store. The following instructions can be used to create
this attribute:

Open the appropriate process application in SBM Composer;

Switch to the Data Design view and navigate to the primary table;

Right click and choose Add New... then Text;

In the property editor, navigate to the General pane;

Set the field name and database field name to an appropriate value to allow easy identification of
the purpose of the field (for example, “TASKTOP_PROXY_ASSOCIATION”);

Navigate to the Options pane;

For Style, choose Fixed length with a size of at least 225 characters;

Save and validate your changes (either from the toolbar or the main menu);

Deploy the process application to make your new field available to Tasktop Sync.

The new attribute will not be visible in the Ul by default. It is not necessary for it to be visible for the
Serena Business Manager connector to work correctly.

Create a Task Mapping for Serena Business Manager
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The final step in configuring Tasktop Sync for Serena Business Manager is to create a task mapping. Please
consult the Task Synchronization Configuration section for detailed instructions on creating and editing
task mappings.

Feature Limitations

Artifact Types
Serena Business Manager artifacts are only supported if they meet the following requirements:

® They include the title field and the last modified date field
® Any required fields are of supported, writable types (see Read-Only Attribute Types section)

Keeping the standard fields that SBM Composer creates when a type is defined is recommended. The
Serena Business Manager connector uses the standard database field names to identify known fields.

Unsupported Features

Tasktop Sync does not support synchronization of comments for Serena Business Manager.

Supported Reports

The Serena Business Manager connector uses saved reports to define its queries. Only reports that
include both the title field and the last modified date field are supported for this use. Again, the standard
database field names are used to identify these fields. The labels can be changed without an issue.

Attribute Limitations

Unsupported Attribute Types
Tasktop Sync does not support synchronization of attributes of the following types:

Folder
Multi-Group
Multi-Relational
Multi-User
Single Relational
Sub-Relational

Read-only Attribute Types
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Attributes of the following types can be read from Serena Business Manager, but values cannot be set into
them:

Single Selection
Multi-Selection
Binary/Trinary
Summation

Status

Tasktop Sync does not support synchronizing the Status attribute.

Rich Text Attributes

Tasktop Sync does not support synchronizing text attributes maintaining rich text formatting (ie. HTML
tags) for Serena Business Manager.

64



Synchronizing Pairs of Connectors

Tasktop Sync allows teams to synchronize tasks across different defect and task tracking repositories. The
Tasktop Sync server application places itself in between repositories to synchronize changes made to the
defects or tasks in either repository.

This section describes how to set up Sync configurations for some common pairs of Tasktop connectors.
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Synchronizing Atlassian JIRA [pre Sync 3.5]
with HPE QC / ALM [pre Sync 3.5]

Task mapping

When synchronizing between Atlassian JIRA and HPE QC / ALM repositories, it is recommended to use
this task mapping:

<t ask- mappi ng conflict-notification-policy="Log">

Most of the attributes in HPE QC / ALM repositories and in JIRA repositories can be mapped using task
IDs instead of keys, including:

® task.common.summary
® task.common.description

Rich Text Conversion

HPE QC / ALM and Atlassian JIRA both can display rich text, but HPE QC / ALM stores the text in HTML
format; Atlassian JIRA stores it in Confluence (wiki-style markup). To ensure that text is legible in both
repositories, a rich text caster should be used. For example:

<attri bute-mappi ng>
<attribute id="task.common. description"
caster="htnl -to-confluence"/> <-- JIRA -->
<attribute id="BG DESCRI PTI ON' caster="
confluence-to-htnm"/> <l -- HPE QT ALM - - >
</attribute-nappi ng>

Dates

Dates do not need a date caster when synchronizing between HPE QC / ALM and Atlassian JIRA. Here
are some examples of dates:

HPE QC / ALM Atlassian JIRA
BG_CLOSI NG_DATE attribute.jira. due
t ask. common. dat e. cr eat ed

t ask. conmon. dat e. nodi fi ed
Value-mapped attributes
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There are several important attributes which do not map directly across from one repository to another,
with severity and priority being the most obvious ones.

The priority values in JIRA are stored as numbers (e.g. “5”), even though they display as values (e.g.
“Trivial”).

Note that the order of urgency is reversed: critical values in HPE QC / ALM tasks are numerically high,
while in Atlassian JIRA tasks, they are numerically low. Additionally, HPE QC / ALM’s notion of Severity
aligns with JIRA’s notion of priority; JIRA does not have a field with the same notion as HPE QC / ALM'’s
priority field.

It is recommended to use a mapping similar to this:

HPE QC / ALM’s BG_SEVERI TY | JIRA’st ask. conmon. priority

5- Ur gent 1
4-Very Hi gh 2
3- Hi gh 3
2- Medi um 4
1-Low 5

Person mapping needs a person caster.
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Synchronizing Borland StarTeam with HPE
QC /7 ALM [pre Sync 3.5]

Task mapping

When synchronizing between Borland StarTeam and HPE QC / ALM repositories, this task-mapping
should be used:

<t ask- mappi ng conflict-notification-policy="Coment">

If comments are not desired for conflict notification, " Log" can be used instead.

Strings
HPE QC / ALM  Borland StarTeam

BG_SUMMARY  Synopsis

Text Conversion

HPE QC / ALM can display rich text, but Borland StarTeam cannot. To ensure that text is legible in both
repositories, a rich text caster should be used. For description synchronization, it is recommended to use
this mapping:

<attri bute-mappi ng>
<attribute id="task.common. descri ption"
caster="htm -to-textile"/> <I-- StarTeam -->
<attribute id="task.common. descri ption"
caster="textile-to-htm"/> <l-- HP ALMQC -->
</attribute-nmappi ng>

Textile is a wiki markup language that does a reasonable job of conveying rich text intentions in plain text.

Dates

Dates do not need a date caster when synchronizing between HPE QC / ALM and Atlassian JIRA. Here
are some examples of dates:

HPE QC / ALM Borland StarTeam
BG_CLCSI NG_DATE M crosoft. VSTS. CMM . Synpt om

BG _DETECTI ON_DATE t ask. conmon. dat e. cr eat ed
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t ask. common. dat e. nodi fi ed

There are several important attributes which do not map directly across from one repository to another,
with severity and priority being the most obvious ones.

StarTeam has only 3 values for severity, so it is recommended to use a mapping similar to this:

HPE QC / ALM’s BG_SEVERI TY | Borland StarTeam’s Severity

5- Ur gent 2
4-Very High 2
3- Hi gh 1
2- Medi um 1
1- Low 0

StarTeam has only three values for priority, 101 (Unassigned), O (No), 1 (Yes), so it is recommended to use
a mapping similar to this:

|[HPE QC / ALM’s BG_PRI ORI TY|Borland StarTeam’s t ask. common. priority
5- Ur gent 1

4-Very High 1

3- Hi gh 1

2- Medi um 0

1- Low 0

Unassi gned | 101

Person mapping needs a person caster.
Common attributes using a person caster include:
HPE QC / ALM Borland StarTeam

BG_RESPONSI BLE | t ask. common. user . assi gned
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The conversion between HTML and textile may not be perfect. In some cases, formatting of text may not
be consistent between the repositories.
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Synchronizing CA Project and Portfolio
Management [pre Sync 4.1] with IBM
Rational Team Concert (using IBM Rational
Team Concert SDK)

This section shows some common mappings between CA PPM® standard task attributes and IBM®
Rational Team Concert™ standard task attributes.

Task mapping

For CA Project and Portfolio Management and IBM Rational Team Concert, this t ask- mappi ng should
be used:

<t ask- mappi ng conflict-notification-policy="Log">

Conmment should not be used as a conflict notification policy, as CA Project and Portfolio Management
does not support comments.

Required Repository Properties

Project

The project attribute identifies the project area of the repository to be used for synchronization. It is requir
ed for both IBM Rational Team Concert and CA Project and Portfolio Management.

ProxyStorageAttribute

The proxyStorageAttribute identifies an attribute that Tasktop Sync will use to store proxy information. It
is required for CA Project and Portfolio Management. It is not necessary for IBM Rational Team Concert.
Required Attribute Mappings

In order for Tasktop Sync to synchronize new IBM Rational Team Concert objects into CA Project and
Portfolio Management, the Ext er nal Task | Dattribute in CA Project and Portfolio Management must
be mapped in an initialization-only configuration. See the CA Project and Portfolio Management
Connector For Sync section for full information on the requirements for the Ext ernal Task | D
attribute. Here is an example of a mapping that could be used for Ext ernal Task | D

IBM Rational Team Concert Attribute = CA Project and Portfolio Management Attribute
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I D External Task ID

The mapping would be one way (from IBM Rational Team Concert to CA Project and Portfolio
Management) and would have a mapping strategy of initialize.

The synchroni zer. xnl snippet corresponding to the above example would appear as:

<attri but e- mappi ng>
<attribute id="task.comon. key" strategy="initialize"/>
<attribute id="id" strategy="ignore"/>

</ attri bute-mppi ng>

String attributes do not need to be transformed with a caster and can be directly synchronized. Here is an
example of a simple string mapping that could be used:

IBM Rational Team Concert Attribute = CA Project and Portfolio Management Attribute

Sumary Sumary

A date caster is not needed when synchronizing between CA Project and Portfolio Management Attribute
and IBM Rational Team Concert repositories. Dates may be synchronized directly.

Boolean attributes do not need to be transformed with a caster and can be directly synchronized.

Status and % Complete attributes

In CA Project and Portfolio Management, the values of the St at us and % Conpl et e attributes are
linked. See the CA Project and Portfolio Management Connector For Sync section for details. This is a
possible value mapping that can be used for St at us:

IBM Rational Team Concert’s | nt ernal St at e = CA Project and Portfolio Management’s St at us
Resol ved Conpl et ed

d osed Compl et ed
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New Not Started
I n Progress Started

Reopened Started

The synchroni zer. xnl snippet corresponding to the above example would appear as the following:

<attri but e- mappi ng>
<attribute caster="val ue-nap" id="status">
<caster-configuration>
<n'ap>
<entry val ue="1" key="2"/>
<entry val ue="0" key="1"/>
<entry val ue="2" key="3"/>
<entry val ue="1" key="6"/>

<entry value="" key="4"/>

<entry val ue="2" key="5"/>

<entry val ue="" key="7"/>
</ map>

</ caster-configuration>
</attribute>
<attribute caster="val ue-nmap" id="internal State">
<caster-configuration>
<|Tap>
<entry val ue="2" key="1"/>
<entry val ue="1" key="0"/>
<entry val ue="3" key="2"/>
</ map>
</ caster-configuration>
</attribute>
</ attri bute-mppi ng>

IBM Rational Team Concert does not have an attribute with equivalent behavior to % Conpl et e.
Therefore, it is recommended that the % Conpl et e attribute either not be mapped or be mapped one
way, from CA Project and Portfolio Management to IBM Rational Team Concert.

Other single select attributes

Other single select attributes, like EV Cal cul ati on Met hod, should be mapped using an appropriate
value mapping, similar to that shown for St at us above.

Please check the Limitations sections of the CA Project and Portfolio Management and IBM Rational Team
Concert documentation for details.
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Synchronizing CA Project and Portfolio
Management [pre Sync 4.1] with Microsoft
Team Foundation Server

This section shows some common mappings between CA PPM® standard task attributes and Microsoft
Team Foundation Server standard task attributes.

Task mapping

When synchronizing between Microsoft Team Foundation Server and CA Project and Portfolio
Management repositories, it is recommended to use this task mapping:

<t ask- mappi ng conflict-notification-policy="Log">

Comment should not be used as a conflict notification policy, as CA Project and Portfolio Management
does not support comments.

Required Repository Properties

Project

The project attribute identifies the project area of the repository to be used for synchronization. It is requir
ed for both CA Project and Portfolio Management and Microsoft Team Foundation Server.

ProxyStorageAttribute

The proxyStorage Attribute identifies an attribute that Tasktop Sync will use to store proxy information. It
is required for both CA Project and Portfolio Management and Microsoft Team Foundation Server.

Required Attribute Mappings

In order for Tasktop Sync to synchronize new Microsoft Team Foundation Server Work Items into CA
Project and Portfolio Management, the Ext er nal Task | Dattribute in CA Project and Portfolio
Management must be mapped in an initialization-only configuration. See the CA Project and Portfolio
Management Connector For Sync section for full information on the requirements for the Ext er nal
Task | Dattribute. Here is an example of a mapping that could be used for Ext er nal Task | D

Microsoft Team Foundation Server Attribute = CA Project and Portfolio Management Attribute

Key External Task ID
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The mapping would be one way (from Microsoft Team Foundation Server to CA Project and Portfolio
Management) and would have a mapping strategy of initialize. The synchr oni zer . xm snippet
corresponding to the above example would appear as:

<attri but e- mappi ng>
<attribute id="task.comon. key" strategy="initialize"/>
<attribute id="task.comon. key" strategy="ignore"/>

</ attri bute-mppi ng>

String attributes do not need to be transformed with a caster and can be directly synchronized. Here is an
example of a simple string mapping that could be used:

Microsoft Team Foundation Server Attribute = CA Project and Portfolio Management Attribute

Sunmary Sunmary

A date caster is not needed when synchronizing between CA Project and Portfolio Management and
Microsoft Team Foundation Server repositories. Dates may be synchronized directly.

Status and % Complete attributes
In CA Project and Portfolio Management, the values of the St at us and % Conpl et e attributes are
linked. See the CA Project and Portfolio Management Connector For Sync section for details. This is a

possible value mapping that can be used for Status.

Microsoft Team Foundation Server’'s St at us = CA Project and Portfolio Management’s St at us

Appr oved Started
Conmitted Started
Done Conpl et ed
New Not Started
Renoved Conpl et ed

The synchroni zer. xnl snippet corresponding to the above example would appear as:
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<attri but e- mappi ng>
<attribute id="status" caster="val ue- map">
<caster-configuration>
<map>
<entry key="New' val ue="0"/>
<entry key="Done" val ue="2"/>
<entry key="Renoved" val ue="2"/>
<entry key="Committed" val ue="1"/>
<entry key="Approved" value="1"/>
</ map>
</ caster-configuration>
</attribute>
<attribute id="task.comon. status" caster="val ue- map">
<caster-configuration>
<map>
<entry key="0" val ue="New'/>
<entry key="2" val ue="Done"/>
<entry key="1" val ue="Commi tted"/>
</ map>
</ caster-configuration>
</attribute>
</ attri bute-mappi ng>

When configuring the mapping for the St at us attribute, keep workflow rules in mind. Specific sequences
of status may be necessary; for example, moving from Newto Conpl et ed might require a move from New
tol n Progress followed by a move from I n Progr ess to Conpl et ed. If these sequences cannot be
mapped directly between repositories, more complicated mappings may be necessary for St at us. See the
Advanced Concepts section for more details.

Microsoft Team Foundation Server does not have an attribute with equivalent behavior to % Conpl et e.
Therefore, it is recommended that the % Conpl et e attribute either not be mapped or be mapped one
way, from CA Project and Portfolio Management to Microsoft Team Foundation Server.

Other single select attributes

Other single select attributes, like EV Cal cul ati on Met hod, should be mapped using an appropriate
value mapping, similar to that shown for St at us above.

You can also synchronize CA Project and Portfolio Management task assignments with a field or a
collection of fields in Microsoft Team Foundation Server, using a scripted attribute handler.

In the following example we set up a one-way mapping, from two fields in Microsoft Team Foundation
Server to CA Project and Portfolio Management task assignments. The two Microsoft Team Foundation
Server fields are cust om assi gnee, a person field, and cust om est i nat i on, an integer field.
Changing cust om assi gnee or cust om est i mat i on will cause a new task assignment to be created
in CA Project and Portfolio Management with its resource ID set to the value of cust om assi gnee and
its estimated time to complete (ETC) set to the value of cust om esti mat i on. Alternatively, if a task
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assignement with that resource ID already exists on the CA Project and Portfolio Management task, that
existing assignment will have its ETC updated to the value of cust om esti mati on.

The attribute handler appears in synchr oni zer . xni as:

<attri bute-handl er | anguage="groovy" id="custom assi gnee" script="
scripts/tfs-fields-to-clarity-assignnents. groovy"/>

<attri but e-handl er | anguage="groovy" id="custom estimation" script="
scripts/tfs-fields-to-clarity-assignnments. groovy"/>

Notice we need to add the handler twice, once for each Microsoft Team Foundation Server field it should
be triggered on.

Here is the full groovy script for the attribute handler:

i nport org. apache. | og4j . Logger
i mport comtasktop.sync.core.strategy. nodel . Attribute
i mport com tasktop.sync. core. strategy. nodel . TaskModel
def map(context, Attribute sourceAttribute, TaskMdel targetTask) {
def CLARI TY_CONNECTOR TYPE = "com tasktop.ca.clarity. ppnt
def ATTR_ASSI GNEE = "custom assi gnhee"
def ATTR ETC = "custom esti mati on"
def M5_PER _HOUR = 3600000
i f (CLARI TY_CONNECTOR TYPE. equal s(t ar get Task. get ConnectorKi nd())){
def sourceTaskData = sourceAttribute.taskAttribute.taskData
def customAssi gneeAttr = sourceTaskData.root.getAttribute
( ATTR_ASSI GNEE)
def assignee = customAssi gneeAttr. val ue
i f( 'assignee.isempty() ) {
def custonEsti mateAttr = sourceTaskData.root.
get Attri bute(ATTR_ETC)
def estimate = 0
if( custonEstimateAttr !'= null && !custonEstinmateAttr.
val ue. i senpty() ) {
estimate = custonkEstimateAttr. val ue.
tolnteger() * MS_PER _HOUR
}
def assignnmentAttr = get O CreateAssi gnment Attr
(target Task, assignee)
assignnment Attr.createAttribute("tasktop.assignnment.
estimate").setVal ue(estimate.toString())

}
} }
def get Or Creat eAssi gnnent Attr( TaskMbdel target Task, assignee) {
def assignmentAttr = findAssignmentAttrByAssi gnee(target Task,
assi gnee)
i f( assignmentAttr == null ) {
assignment Attr = targetTask.root.createAttribute("tasktop.
assi gnnent - new")
assignnent Attr. get MetabData(). defaul ts(). set Type("t asktop. type.
assi gnment ")
assignnent Attr.createAttribute("tasktop.assi gnnment. assi gnee").
set Val ue(assi gnee)

}

return assignmentAttr
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}
def findAssignnent AttrByAssi gnee(TaskMbdel targetTask, assignee) {
def taskData = target Task.taskDat a
def assignmentAttrs = taskData.attributeMapper.getAttributesByType
(taskData, "tasktop.type.assignment")
for( assignnmentAttr in assignhmentAttrs ) {
def assigneeAttr = assignmentAttr.getAttribute("tasktop.
assi gnnent . assi ghee")
i f( assigneeAttr !'= null && assigneeAttr.value == assignee ) {
return assignnment Attr
}

return null

}

The script first finds the values of the cust om assi gnee and cust om est i mat e fields on the
Microsoft Team Foundation Server task. It then checks if the CA Project and Portfolio Management task
already has an assignment with the resource ID specified by cust om assi gnee. Task assignments are
accessible as “assignment” attributes in the script. The method f i ndAssi gnnent At t r ByAssi gnee gets
all assignment attributes from the CA Project and Portfolio Management task data and searches for one
whose t askt op. assi gnnent . assi gnee child attribute has this value. If a matching assignment
attribute is not found, we create a new one. The method get Or Cr eat eAssi gnnment At t r creates a new
attribute and sets its type to t askt op. t ype. assi gnnent . It then creates the child attribute t askt op.
assi gnnent . assi gnee and sets its value. Finally, we find or create a new t askt op. assi gnnent .

est i mat e child attribute under the assignment attribute, and set its value.

Note that the value of cust om assi gnee is hot mapped or transformed, so this script will only work if
Microsoft Team Foundation Server and CA Project and Portfolio Management have the same users (for
example, they share an LDAP server).

For more general information on CA Project and Portfolio Management task assignments, see CA Project
and Portfolio Management Connector For Sync: Task Assignments.

Please check the Limitations sections of the CA Project and Portfolio Management and Microsoft Team
Foundation Server documentation for details.
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Synchronizing IBM Rational DOORS Next
Gen [pre Sync 4.0] with HPE QC /7 ALM
[pre Sync 3.5]

This section shows some common mappings between HPE QC / ALM standard task attributes and IBM®
Rational DOORS Next Gen™ standard task attributes.

Setting up the proxyStorageAttribute property
Sync requires that the IBM Rational DOORS Next Gen repository has a proxyStorageAttribute property.

For information on how to set this up, refer to the instructions on how to set up the
proxyStorageAttribute property.

Task mapping

For IBM Rational DOORS Next Gen and HPE QC / ALM, this t ask- mappi ng should be used:

<t ask- mappi ng conflict-notification-policy="Log">

Strings

String attributes do not need to be transformed with a caster and can be directly synchronized. Here is an
example of a simple string mapping that could be used:

HPE QC / ALM Attribute | IBM Rational DOORS Next Gen Attribute

Nanme Summar y

Dates

A date caster is not needed when synchronizing between IBM Rational DOORS Next Gen and HPE QC /
ALM repositories. Dates may be synchronized directly.

IBM Rational DOORS Next Gen DateTime, Time and Duration field types are not supported for
synchronization.

Boolean attributes
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Boolean attributes may be synchronized directly; however, HPE QC / ALM does not support boolean
values. Boolean attributes will be treated as strings in HPE QC / ALM during a synchronization.

IBM Rational DOORS Next Gen tasks have an Uncl assi f i ed value for severity, while HPE QC / ALM
tasks do not. The Severi ty field is required, so one of the following actions should be taken:

remove the Uncl assi fi ed value from IBM Rational DOORS Next Gen,

make Severity notrequired,

add an Uncl assi fi ed value to HPE QC / ALM,

map the IBM Rational DOORS Next Gen Uncl assi fi ed value to another value in HPE QC / ALM

HPEQC/ALM'sPriority IBM Rational DOORS Next Gen's Severity

5- Ur gent Bl ocker
4-Very Hi gh Critical
3- Hi gh Maj or
2- Medi um Nor mal
1- Low M nor

If users have the same user IDs on both repositories, then these attributes can be synchronized directly. If
not, then a person mapping will need to be defined, as described in Person mapping definitions

To use the Person mapping, each attribute that has a person type needs to use a per son caster, for
example:

<attri but e- mappi ng>
<attribute caster="person" id="RQ REQ AUTHOR'/ >
<attribute caster="person" id="dc:creator"/>

</ attribute-mappi ng>

Some attributes that may require person mappings:

HPE QC / ALM Attribute | IBM Rational DOORS Next Gen Attribute

Aut hor Reporter
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To configure Folder Sync from IBM Rational DOORS Next Gen to and from HPE QC / ALM, first ensure
that the folder structures in IBM Rational DOORS Next Gen and HPE QC / ALM match. For example,
folder structures for IBM Rational DOORS Next Gen and HPE QC / ALM could be set up as follows:

Reqguirementz  Edit  “iew Favoriies  Analysi
i IE ﬁ:' ? - EI |_£| -
Filter by Folder = B X | o NN
- I=F Requirements Project | Mo Fitter Defined
) Hame 4
=] & Features - Requirements
(= Advanced Features = Features
+ ] Advanced Features
.= Basic Features [ | Basic Features
= Glossaries and Terms E Glossaries and Tems
[ Man-Functional Requireme..
= Non-Functional Requirements ] Uszer Stary Elaborations
== User Story Elaborations

Next, ensure that requirement folder configuration is configured to be retrieved from the HPE QC / ALM
repository by checking the configuration option in the Repository Settings Dialog.

é .ﬂ O S Properties for TESkReI.;I-);IK_[;l_’;- -

HPE QC[ALM 10 and HPE QC/ALM 11 Repository Settings (Tasktop Enterprise)
Supports HPE QC / ALM 10, HPE QC/ ALM 11, and Agile Manager :

You are running Mac OS5 which can only only connect to HPE OC / ALM 11
Please use a 32-bit Windows version to connect to HPE QC [ ALM 10.

Server: http:/ {4 - - n:8080/qcbin *
Label HPE QC / ALM 11 [ Disconnected

User ID: | tasktop|

Password: | weeess @ Save Password
Domain SYNCHRONIZER v] | Refresh |
Project Tasktop L

« Additional Settings

Server Version: | HPE QC / ALM 11 (REST) 3
Locale: | Default [English (United States)] 3
Maximum numher of items retrieved ner reouest: 10 s

@ Update requirement folder structure during repository configuration update.
[ AI0E EnLIty KING Prenx in 1dask List view

|_| Show Reguirements Hierarchy in Task List

@] Check required fields before submitting

@] Enable network compression (REST only)

-

Proxy Server Configuration

b Task Editor Settings

| [__EJ Walidate Settings | | Cancel | [ Finish ]
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Then ensure that the repository schema for each repository is current and refresh if necessary.

Folder synchronization can then be configured by adding an attribute mapping for the Requi r enrent

Fol der attribute in IBM Rational DOORS Next Gen to the Requi r ement Fol der attribute in HPE QC /
ALM. No casters or other transformations are required. For example, configuration can be set up as
follows:

Attribute Mappings

Direction = ALM 11 Attribute
<=> (Bidirectional) ] [Requirement Folder

<<<<<<

b Advanced

The synchroni zer. xm should contain configuration similar to the following:

<attri but e- mappi ng>
<docurnent at i on></ docunent ati on>
<attribute id="comtasktop.ibmrrc.folder"/>
<attribute id="RQ REQ FOLDER'/ >

</attri bute-nappi ng>

® Folder Sync is only available for IBM Rational DOORS Next Gen with HPE QC / ALM 11 and higher.
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Synchronizing IBM Rational Team Concert
(using IBM Rational Team Concert SDK)
with HPE QC / ALM [pre Sync 3.5]

This section shows some common mappings between HPE QC / ALM standard task attributes and IBM®
Rational Team Concert™ standard task attributes.

Task mapping

For IBM Rational Team Concert and HPE QC / ALM, this t ask- mappi ng should be used:

<t ask- mappi ng conflict-notification-policy="Conment">

If comments are not desired for conflict notification, " Log" can be used instead.

Strings

String attributes do not need to be transformed; they can be synchronized as is. Here are some examples
of simple string mappings that could be used:

HPE QC / ALM Attribute | IBM Rational Team Concert Attribute
BG_SUMVARY Sumary

BG_DESCRI PTI ON Descri ption

It is recommended for rich text attributes such as Description that the ht ml -t o- RTCRi chText and RTCR
i chText -t o- HTM. casters are used, this is accomplished by selecting HTM. for HPE QC / ALM and RTCR
i chText for IBM Rational Team Concert as the markup language in the attribute mapping editor.

Dates

A date caster is not needed when synchronizing between IBM Rational Team Concert and HPE QC / ALM
repositories. Dates may be synchronized directly.

Value-mapped attributes

There are several important attributes which do not map directly across. IBM Rational Team Concert tasks
have an Uncl assi f i ed value for both severity and priority, while HPE QC / ALM tasks do not. The Seve
rity field is required, so one of the following actions should be taken:
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remove the Uncl assi fi ed value from IBM Rational Team Concert,

make Severity notrequired,

add an Uncl assi fi ed value to HPE QC / ALM,

map the IBM Rational Team Concert Uncl assi fi ed value to another value in HPE QC / ALM

HPE QC / ALM’s BG_SEVERI TY | IBM Rational Team Concert's Severity

5- Ur gent Bl ocker
4-Very High Critical
3- Hi gh Maj or
2- Medi um Nor mal
1- Low M nor

Pri ori ty has asimilar issue, but is not a required field in IBM Rational Team Concert as-installed.

HPE QC / ALM’s BG_PRI ORI TY | IBM Rational Team Concert'sPriority

5- Ur gent Hi gh
4-Very Hi gh Hi gh
3- Hi gh Hi gh
2- Medi um Medi um
1-Low Low

Note that when mappings are made for priority and severity, it is important for there to be consensus on
the meaning of priority versus severity.

If users have the same user IDs on both repositories, then these attributes can be synchronized directly as
strings. If not, then a person mapping will need to be defined, as described in Person mapping definitions

To use the Person mapping, each attribute that has a person type needs to use a per son caster, for
example:

<attri but e- nappi ng>
<attribute key="BG DETECTED BY" caster="person"/>
<attribute key="BG DETECTED BY" caster="person"/>
</attri bute-mappi ng>

Some attributes that may require person mappings:
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HPE QC / ALM Attribute ' IBM Rational Team Concert Attribute
BG _DETECTED BY Cr eat or

BG_RESPONSI BLE Owner
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Synchronizing Serena Business Manager
[pre Sync 4.1] with HPE QC / ALM [pre
Sync 3.5]

This section shows some common mappings between Serena® Business Manager standard task attributes
and HPE QC / ALM standard task attributes.

Task mapping

Comment should not be used as a conflict notification policy, as the connector for Serena Business
Manager does not support comments.

Strings
String attributes can be directly synchronized without a caster.
Here is a typical string mapping that could be used:

Serena Business Manager Attribute = HPE QC / ALM Attribute

Title Summary
Description Description
Numeric attributes

Serena Business Manager provides 4 types of numeric attributes:

integer
float
precision
summation

Fields based on the integer and float types can be directly synchronized without a caster.

Precision types are configured with a fixed number of decimal places, and while fields based on the
precision type can be directly synchronized, numeric values may be altered to match the number of
configured decimal places when they are being transferred between HPE QC / ALM and Serena Business
Manager.
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The summation type is used to define calculated, read-only fields. Since these are read-only, fields based
on the summation type can only be directly synchronized from Serena Business Manager into HPE QC /
ALM.

Date/Time attributes

Serena Business Manager provides 4 variations of date/time attributes:

date only
time only
date & time
elapsed time

Date and date & time fields can be synchronized directly without a caster.

Time only fields will contain numeric values between 0 and 86,400 (the number of seconds in a day) and
can be directly synchronized.

Similarly, elapsed time fields will contain a numeric value measured in seconds and can be directly
synchronized.

Single-select attributes

Due to functional limitations (see Limitations for Serena Business Manager section), single-select fields in
Serena Business Manager are treated as read-only. Due to this limitation, single-select fields can only be
synchronized from Serena Business Manager into HPE QC / ALM. Synchronizing to string fields in HPE
QC / ALM will be the easiest, but more complex solutions can use techniques like scripting to map them
into other types in HPE QC / ALM.

Boolean attributes

Boolean attributes in Serena Business Manager are assigned a type of binary/trinary. Due to similar
functional limitations (see Limitations for Serena Business Manager ), binary/trinary fields in Serena
Business Manager are treated as read-only, and hence can only be synchronized from Serena Business
Manager into HPE QC / ALM. Synchronizing to string fields in HPE QC / ALM wiill be the easiest, but more
complex solutions can use techniques like scripting to map them into other types in HPE QC / ALM.

Person attributes

Person attributes can be synchronized through a Person mapping caster. Person mappings will
subsequently need to be defined between Serena Business Manager and HPE QC / ALM.

To use the person mapping, each attribute that has a person type needs to use a Person mapping caster,
for example:
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<attri but e- mappi ng>
<attribute caster="person" id="OMNMER'/>
<attribute caster="person" id="BG RESPONS|I BLE"/ >
</ attri bute-mppi ng>

Here is a typical person mapping that could be used:
Serena Business Manager Attribute = HPE QC / ALM Attribute
Owner Assigned To

Submitter Detected By
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Synchronizing Time Worked From Atlassian
JIRA [pre Sync 3.5] to CA Project and
Portfolio Management [pre Sync 4.1]

The Time Worked Synchronization feature utilizes Tasktop Synca€™s existing Atlassian JIRA and CA
PPM® connectors to facilitate time tracking and monitoring across Development and the PMO,
aggregating and synchronizing work logs entered by developers on JIRA issues to timesheets for
corresponding tasks in Project and Portfolio Management, where the PMO can monitor this data.

Setting up Project and Portfolio Management for Time Worked
Synchronization

Before work logs from JIRA issues can be synchronized to timesheets in Project and Portfolio
Management, the following configurations should be made to ensure that Project and Portfolio
Management is set up for time entry.

Ensure all users who will be logging time are configured for time entry. For each user:

1. Navigate to the Resour ces page in Project and Portfolio Management and click on the user to edit
2. Navigate to Properti es ->Properti es ->Gener al and setthe Track Mbde optiontod ari t)
3. Navigate to Properti es ->Access to this Resource ->Resour ce and add the Resour ce

- Enter Ti ne access right for the Tasktop Sync user

Clarity PPM

Resource-Labor: Joseph Kasper - Main - General
Utz of | eminaten

BlAvaiabity 500
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Clarity PPM 2 tasitoptaskiop Logout | Help | About
cC & 00

Last Name Resource D
First Name AccessRight Al

Shows All

Last llamea.

Displaying 1- 4 of &

Ensure all users who will be logging time are team members of all projects whose tasks they will log time
against. For each project:

1. Navigate to Hone -> Portfoli o Managenent -> Proj ect s and click on the project to edit
2. Navigate to the Teamtab and ensure that all users who will log time against tasks in this project are
in the list of team members

Clarity PPM £ tasitoptaskiop Logout | Help | About
cC A OO0
Properties Team ~ Tasks Financial Plans Risks/lssues/Changes Collaboration Processes Dashboard
Project: MegaMarket Web App - Team - Staff E5 Actions ~
O Filter: System Default v [+

Booking  Request
Role  Time Status Status  Start  Finish % Allocation Allocation Actuals ETC

1= v son Hew 102813 1072813 100% 800 000 0.00
2= v son Hew 102813 1072813 100% 800 000 0.00

Displaying 1- 2 of 2

Save Add Add/Update by 0BS @ Remove

Ensure all projects whose tasks will have time logged against them are configured for time entry. For each
project:

1. Navigate to the Pr oj ect s page in Project and Portfolio Management and click the project to edit
2. Navigate to Properti es ->Properties ->Schedul e and set the Track Mde optionto d ari
ty

Clanty PPM 2 tasktop tasktop Logout | Help | About

Project: MegaMarket Web App - Properties - Main - Schedule
L e =

% Complete  0.00%

Tracking

Time Entry

Ensure that all time reporting periods in which time will be logged are in the Open state:

1. Navigate to Adm ni strati on ->Proj ect Managenent ->Ti ne Reporting Peri ods
2. Ensure each time reporting period has a check mark in its Qpen column
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Clarity PPM

Open
v
v
v
v
v
v
v
v
v
v
v

11

ELELE

Hewr l @ Close l < Mark for Deletion l « Cancel Deletion

Once Project and Portfolio Management has been configured for time entry, Tasktop Sync can be set up
to synchronize JIRA work logs to Project and Portfolio Management timesheets:

1. Create a mapping between JIRA and Project and Portfolio Management (see CA Project and
Portfolio Management Connector For Sync and Atlassian JIRA Connector For Sync for details on
setting up mappings with these connectors).

2. Open the Sync Mapping Editor and navigate to the Mappi ng Sett i ngs section of the Over vi ew
tab. Open the Ti mre Wor ked Synchr oni zat i on drop down menu and select the option to
synchronize from JIRA to Project and Portfolio Management.

3. Ensure that a Person Mapping is configured. Synchronization of time worked uses the Person
Mapping to map users who are logging time. See Person Mapping Files for details on how to
configure a Person Mapping.

Mapping Settings
Person Mapping: Browse Comment Synchronization:

stach
Conflict Notification Policy: -
ConflctReselutionpelicys || e WorkedSynchroniet

ion: [JIRA to Clarity PPM <
HIIRA to Clarity PPM ]
No synchronization

Tasktop Sync is now configured to synchronize time worked from JIRA to Project and Portfolio
Management.

With Tasktop Sync’s Time Worked Synchronization feature, all work logs entered on JIRA issues will be
synchronized to Project and Portfolio Management timesheets:

1. InJIRA’s web application, open an issue. From the Mor e Act i ons drop down menu, select Log
Wor K. In the wizard enter the amount and start date of the time worked and click Log.

2. When Tasktop Sync has finished processing the change, open the Ti nesheet s page in Project and
Portfolio Management. On the timesheet for the user who logged the time in JIRA, the time worked
should now be entered under the correct day, in the row corresponding to the task on which it was
logged.
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3. Additionally, if the user had not yet been assigned to the task for which the time was logged, notice
that an assignment has been created for the user on that task in Project and Portfolio Management.

2 MegaMarket Web App / MN-2
user can save items in shopping cart Retumto
2 Edit | Assign AssignToMe Comment More Actions = | Resolve lssus  Close lssue | Vorkiow = @
Updated Today
Activity Time Tracking
Estimated om
Al Comments | Work Log | History Actiity Source Reviews
Remaining %
Fluoseph Kasper logged work - 03/Sep/13 1-54 PM Lot o 20 L

Time Spent 2 hours, 30 minutes
<No comment>

Comment

Bug tracking and projecttracking for software development powered by Atiassian JIRA (v5.08713-shat:aec58e2) | Reporta problem

- [ et Fc PG
Clarity PPM '
4+ cAaOp0
Timesheet
Time Period: 911413-9713  [] o
Resource Name  Joseph Kasper jgg Wodified by taskiop taskiop
Tmesheet Status  Open Last odified 1072813 8:21 PI1
Input
Type Charge  Sun mon Tue  wed  Thu Fri sat
[ | investment Description  Code Code 91 a2 £E) 514 a5 a6 . Total ETc
B Tasks
[F] [ MegaMarket user can save tems 250 250 0.00
WebApp i shopping cart
Total 0.00 0.00 2% 0.00 0.00 0.00 0.00 250
Add Task « Split « Delete IEonoRl
Save Submit for Approval Populate Cance [ R

Work Effort = Hours.

Clarity PPM 2 tasktop tasktop Logout | Help | Abou
<~ cC A OO0
Associated Risks/lssues
Project: MggEMa_rket Web App | Task: user can save items in shopping cart - Task Properties

TasktopSync_ProxyTaskType  TASK #

Assignments

(<] Usage

Loading Qctober 2013 Hovember 2013 De
i Resources Resource D Role  Start  Finish Actuale ETC Pattern 102813 11413 1111143 1114813 112513 121213 120913

[C] @ Kaser Joseph jkasper 102813 102813 0.00 0.00 £TC
Actuals

Note on Time Zone Settings in Atlassian JIRA

In the JIRA web application, a user can select the time zone in which dates will be displayed. However, all
dates are stored internally in JIRA in GMT,; this user preference merely affects how one user will see dates
when logged into the web application. Project and Portfolio Management timesheets store and display all
dates in GMT. Thus if a JIRA user sets his or her time zone preference to anything except GMT there may
be an apparent discrepancy between work logs logged against JIRA issues and the timesheet entries
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synchronized to Project and Portfolio Management. To avoid this confusion, JIRA users may want to set

their time zone preference to GMT.

Update User Preferences
Email Type | HTML
o

My Changes | Notify me
Whether to email notificatiens of any changes you make

Sharing | Unshared

wwwww

Known Limitations

Tasktop Sync’s Time Worked Synchronization has the following known limitations:

Tasktop Sync will log time for a Project and Portfolio Management user regardless of whether or
not Qpen for Time Entry isenabled in that user’s properties.

Tasktop Sync will log time against tasks in a project regardless of whether or not Ti me Entry is
enabled in that project’s schedule properties in Project and Portfolio Management.

Tasktop Sync will always create missing assignments on tasks for which time is logged, regardless of
whether or not Pr event Unassi gned Ti mesheet Tasks isenabled in a project’s schedule
properties in Project and Portfolio Management.

Deletion of time worked is not supported. If a user deletes a work log on a JIRA issue, the results in
Project and Portfolio Management’s timesheets may vary.

Splitting of timesheet entries in Project and Portfolio Management is not supported. If a timesheet
entry is split, Tasktop Sync will fail to synchronize time worked to it.

Time logged in JIRA will always overwrite time logged in Project and Portfolio Management, and
changes made to a timesheet in Project and Portfolio Management will not be synchronized back to
JIRA.

In order to synchronize time worked into a Project and Portfolio Management user’s timesheet for a
particular time period, that timesheet must be in an editable state (i.e. either Open, Open

(Adj ust ment ), Ret ur ned, or Ret urned ( Adj ustnent)).
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